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1Chapter 1 Introduction

1Introduction

Digital WarRoom® (DWR) is an e-discovery solution bringing together analysis, document
processing, document review and production capabilities in one software package. Designed for
use by in-house counsel and law firm legal support departments, Digital War Room is backed by the
over 15 years of proven work flows, methodologies and technology used by our consulting group.
This software allows legal professionals to address e-discovery obligations in a proven and cost-
effective manner. Attorneys and litigation support professionals can process, analyze, review, and
produce documents all with one integrated solution. The result – greater efficiency, accuracy, and
control.

 DWR includes support for the following – all at an affordable cost:

· Pre-review document analysis – gives legal teams a snapshot to quickly scope document
volumes and assess review resource requirements. 

· End-to-End Solution – from identification to post-production, including deposition
preparation with a few clicks of a mouse.

· Inventory, process, cull, filter, review, and convert documents with a single application. 

· Matter management and document control – allows teams to track and manage content
and assets. 

· Create matter-specific collections for re-use (no need to re-process). 

· Export documents with third-party load files. 

· Auditable – single interface for reports and chain of custody. 

· Native file review platform: simple, easy-to-use interface to support quicker review. 

· Efficient, rigid production work flow. 
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2What's new in 10.0?

· DWR 10.0 includes an all new icon set with a modernized tab
styling

· To clear up screen space, users will now toggle between
filters, advanced filters and saved searches using a drop
down. Items in the filter tree have been reorganized and
styled.

· The search bar has been restyled, and now offers additional
functionality in the drop down menu and an all new Results
to feature described below.

· The keywords pane offers the same great functionality with a
nice visual refresh

 

New Features
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2What's new in 10.0?

· View Multiple Docs at Once: Multiple documents can be
opened at the same time side by side. Click the + on the
document browser to open them in new browsers

· Create Collections From a txt File: Right-click -> Create
Collections From List on top "Collections" node in Manage
Collections

· Results to.... : Ctrl-click the Search button to quickly add all
results of a search to a single binder or Draft production

· Column Filtering: Ctrl-F to toggle excel-like column filtering.
In the dropdown under a column header, select the values you
would like to filter on.

· Check for Bates Gap: Users can now check for bates gaps
manually without having to finalize the production. Added
menu option (right-click production -> Tools... -> Check for
Bates gaps. For documents processed with a load file a report
is available in Reports to note any bates gaps.

· Custom DAT Delimiters: Select a custom DAT delimiter in the
production export window

· Custom Field Names for Exporting Productions: Custom field
names can be entered in the production export window

 

Moved Functionality

· Main Views Review, Draft and Produced are now always visible
as tabs at the top of the filter tree

· Manage Collections: is found under the "Process" menu.
Manage Collections is what we previously called "Processing".

· Review Policy: is now available under the "Settings" menu.
Policy is now set on the matter level. Policy is autoset to de-
dup within the collection and post all viewable files. To modify
after posting use the Review Policy option.
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2What's new in 10.0?

· Reports: is now found under the "Analysis" menu

· View Jobs: is now its own window and can be found under the
"Process" menu

· Create Assignments: is now an option in the drop down next
to the search bar

· Assign Custodians: now occurs in the Manage Collections
window during processing

· Special Filters: has been promoted to the top level of the filter
tree

Options chosen under Find Documents (left side of screen) determine what is displayed in the
Current Docs grid screen(middle of screen). Selecting documents in the Current Docs grid screen
drives what is displayed in the Document Browser (right side of screen).

Other windows like Thread Visualizer, Tabulate, and the Work Product Inspector are displayed after
choosing these options in Tools or Analysis at the top of the screen.

With multiple monitors, certain parts of the interface can be moved to a second screen (like the
Document screen) to make review more efficient. 

Views

There are three main functional Views within DWR: Review, Drafts, and Produced. 

Review Drafts
Produced
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3The DWR Interface
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3The DWR Interface

For more information on these three views go the corresponding section of the User Guide: 

Review Drafts
Produced 

Docking/Un-docking Movable Windows

The following windows can be "un-docked" from the main interface and can be moved to other
screens or "re-docked" within the main interface in different locations: Document screen, Current

80 153

188
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3The DWR Interface

Docs Grid Screen, Work Product Inspector, Thread Visualizer, Who to Whom, Keyword Analysis,
Tabulate, and Date Histogram.

To un-dock a movable window double-clicking the title bar of the window OR click on the title bar
and drag it away from the DWR interface (i.e. ripping it off).

To re-dock a movable window, double-click the title bar again and it will re-dock into the DWR
interface. Drag a floating window over the DWR interface and a docking guide (pictured in the
middle of the screen shown below) will appear to specify where the window to should be
positioned inside the DWR interface. Drag the window onto the desired directional indicator and
let go and the window will dock in that location. 

The directional indicators help you re-dock floating windows
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3The DWR Interface

A Matter is a database that contains all of the documents for a particular case or issue.

Within the Matter menu the following are available:

· Open an Existing Matter Database – Ctrl+Shift+O

· Creating a New Matter – DRW PRO

· Creating a New Matter - Hosted Single Matter

· Creating a New Matter - Private Cloud

· Properties – Ctrl+Ins

· Refresh Environment

· Reset Layout

· Create or Request Archive

· Close-Out and Delete a Matter

Open an Existing Matter Database – Ctrl+Shift+O

To open an existing Matter, from the Matter menu, click Open:

In the Open Matter dialog select a Matter by clicking the Client and Matter name and selecting
Connect.
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4Matter

Note: If the Matter needed is not displayed, modify the Matter server to access matters assigned to
another SQL server.

Important: SQL Server authentication requires a username and password that might be different
from your Microsoft Windows username and password. See your system administrator if you
require a SQL Server username and password, and type them in the appropriate fields.

Creating a New Matter – DWR PRO

There are three components for creating and accessing a Matter. It is important to understand and
specify the location of each component. 

1. The User Interface or end-user machine. This is where the log-in icon is located. It is also the
local user's desktop.

2. The document repository - the location where preserved documents are stored. For large
Matters this is often a server or network storage device containing many terabytes of disk space.
In some companies and firms the network storage device may be referred to by a simple name
or a drive letter (ie. X:)

3. The Matter database or work product repository. Each Matter has a database that collects user
input and directs traffic between the user interface and the document repository. The Matter
database could be on the same machine as the User Interface and/or the document repository.
The location of the Matter database must be defined by the operating system and not by a
simple name. 
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4Matter

Recommended for Single-User DWR Pro environment - The User Interface, document repository
and the Matter database should all be on the same machine.

Recommended for the Multi-User DWR Pro environment - The document repository and database
are best set up on the same machine with end users using RDP to access the database and
document repository.

From the Matter menu click New:

 The Create New Matter dialog box appears:

When a new Matter is created several settings and configurations must be designated.

1. Ensure SQL is Setup

Hosted users should already have SQL installed in their environment – move on to step 2.

For Digital WarRoom Pro users, first install SQL onto the local machine. The install link is included on

our DWR Pro Onboarding Page. The defaults options are successful in most environments, however

https://www.digitalwarroom.com/products/pro-software/onboarding-guide
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there are a couple points to keep in mind outlined in our video tutorial: SQL Server Download and

Installation Instructions.

Most importantly, when given the opportunity to set a SQL instance name we highly recommend to

take the default, as outlined in the video. The default instance name should be "MSSQLSERVER".

2. Matter Server Field

In the Matter Server field, type the matter server name. What you type here will depend on the

instance name you entered when SQL was configured.

· If you took the defaults, as recommended in the SQL install video, enter your Machine

Name. You can reference your machine name by simply typing "." or "localhost".

· If you set a custom instance name during SQL installation, type the instance name here.

3. Windows Authentication Field

In the authentication field, click either Windows Authentication or SQL Server Authentication.

Default value is Windows Authentication.

· Windows Authentication: This option should be picked in almost all scenarios. For Pro users.

Windows authentication will work correctly assuming you clicked the "Add Current User"

button during SQL installation.

· SQL Server Authentication: This option is for more advanced users that have set up a custom

SQL account

4. In the Client and Matter fields, type the associated Client and Matter name. These fields are

metadata for your own use and will not affect Matter setup. Optionally, a Bill Code can be

provided, Contact Info, and a Description of the Matter. This matter-level information is

available for editing by going to Matter->Properties at any time in DWR.

 Manage document location

5.    Specify either a network (UNC - Universal Naming Convention) or local path for the

repository location. The default location is C:\DWR. 

Important: If choosing a UNC path please ensure your system administrator has given access to the
folder or repository.

Advanced Options:

https://www.youtube.com/watch?v=ybZz83LIa4k
https://www.youtube.com/watch?v=ybZz83LIa4k


12 Chapter 4 Matter

4Matter

Manage work product database location

In Database Location specify a location for DWR to create the database files. 

· The location must already exist on the SQL server.

· The database location cannot be set as a UNC path. 

Important: The third box in Database Location allows users to automatically use settings from an
existing Matter. Click on the drop down to choose an existing Matter that you want to use as a
template for your settings. (This feature is used when a firm handles numerous cases that will have
the same Marks and Issue codes. These settings will not need to be recreated for each new Matter
but will be mirrored from the existing Matter in the New Matter.)

Creating a New Matter - Hosted Single Matter

Creating a New Matter in a Hosted Single Matter is a simple as going to our
website: https://www.digitalwarroom.com

https://www.digitalwarroom.com/pricing
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4Matter

Once you are on the pricing page go to the middle column of the screen - DWR Single Matter and scroll to the bottom to click on
Request Contract:

This will lead you to a 5-step process that will walk you through creating a new Matter:

For Hosted Single Matter - Digital WarRoom helpdesk will manage access control
for you. Contact the helpdesk at support@digitalwarroom.com

mailto:support@digitalwarroom.com
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4Matter

Creating a New Matter - Private Cloud

To create a new Matter several settings and configurations are necessary. It is recommended for
Hosted Private Cloud clients to use the default location settings.

From the Matter menu click New:

 The Create New Matter dialog box appears:

In the Matter server field, type the Matter Server name. Depending on how the SQL Server was
configured, you may need to include the SQL Server instance name (i.e.
MACHINENAME\INSTANCENAME). See our YouTube tutorial: SQL Server Download and Installation
Instructions 

In the Authentication field, click either Windows Authentication or SQL Server Authentication. The
default value is Windows Authentication.

In the Client and Matter fields, type the associated Client and Matter name. Optionally, provide Bill
Code, Contact Info, and a Description of the Matter and click Create matter.

https://www.youtube.com/watch?v=ybZz83LIa4k
https://www.youtube.com/watch?v=ybZz83LIa4k
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The matter is created displaying a progress bar

It is recommended that Hosted Private Cloud use the default settings in the Database Location
dialog box.

Important: The Advance Options tab allows users to automatically use settings from an existing
Matter. Click on the drop down to choose an existing Matter to use as a template for the matter
settings. (This feature is used when a firm handles numerous cases that will have the same Marks
and Issue codes. These settings will not need to be recreated for each new Matter but will be
mirrored from the existing Matter in the New Matter.)
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4Matter

Properties – Ctrl+Ins

From the Matter menu select Properties to modify the client, matter, bill code, contact info or
description assigned when the matter was created.

Refresh/Reset

Refresh Environment - Ctrl+F5

When new data has been loaded, new binders are created or custodians assigned to the Matter use
this option to refresh all of the filter options in the database.
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Reset Layout

To reset to the default window layout and reset the column layout select this option. 

Create or Request Archive

Archiving a Matter is the process of backing up data records from an operational database and
storing them in an archive where they can be retrieved or delivered to DWR’s hosted service if
needed. 

For cloud customers from the Matter menu, select Request Archive which will notify the network
team of the request.

For PRO users select Create Archive.... 

Browse to the locate for the archive to be created:

Once completed a notification will appear and the location of the archive will open in Windows
Explorer:
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Close-Out and Delete

Important: This action is not reversible. A matter cannot be retrieve or restore once it is deleted
without a prior archive – See ...  . Deleting a Matter deletes both the database and the document
repository. 

From the Matter menu, click Close-Out and Delete:

The Matter Deletion dialog shows the size and number of documents in the Matter to be deleted:

17
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Type "YES" in the text box, then click Delete!

The Process view is the primary tool for cataloging documents and preparing them for use in a
Matter. This includes documents "contained" within other files, such as emails, attachments, and
documents embedded in .zip files and other archives.

• Catalog contents received from the provider, creating a unique digital fingerprint for each
document

• Extract the content of container files

• Detect and report potential files that the processing engine does not extract content from,
and log them as exceptions

• Capture and record relevant metadata

• Facilitate the loading of data into the database 

• Ingest adverse productions

• Manage the collections and their hierarchy

• View long running "jobs" 

Document Types

DWR processes all file types. However, DWR also extracts content and/or categorizes documents
based on file extension.

Below is the list of special file extensions and how they are treated:
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General Document Containers
Contents of these containers are always extracted

7z

lzh

rar

zip

zipx

tar

gz

tgz

Mail Containers
Contents of these containers are always extracted, preserving
family relationships

dbx

eml

emlx

mbox

mbs

mbx

msg

p7m // encrypted email format

pmm

pst

qim

sbd

Office Documents
Search for embedded documents

docx

pptx

ppsx

xlsx

Other Known
Extensions
Recognized but content is not extracted

ace

arc

arj

bz // unix archive

bz2

bza
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cpio

czip

dmg

gca

gza

gzip

hqx

lha

lzs

nsf // lotus notes mail

ost // outlook/exchange cache file

pak

pk3

rpm

sea

sit // mac stuff-it file

sitx // mac stuff-it extended file

snm // unix mail

taz

tbz

wad

war

x-stu

Load File Formats
These are recognized as standard production loadfiles

opt

lfp

Assumed Image File Types
bmp

dwg

gif

jpeg

jpg

pdf

png

tif

tiff

Assumed Binary File Types
bin

cmd
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com

dll

exe

msp

ocx

reg

Manage Collections

Click on Manage Collections to add data to your Matter.

Adding Documents

To add documents to a matter, go to the Process Menu to Manage Collections and create a
Collection:

 Right-click on Collections and choose New Collection:

 Type in the name of the new collection:

Right-clicking on an existing Collection will create a new sub-Collection under the existing
Collection:
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Renaming collections can be done in the same manner as renaming a folder in Windows i.e. click
and hold on the node briefly, then release the mouse click and the collection name will become
editable. Additionally the F2 keyboard short cut will enable the collection to be renamed.

There are several ways to start adding documents ("Imports") into Collections

Drag and drop a folder, file, directory, or lfp/opt file onto an existing Collection in the collections
tree OR drag and drop onto the imports grid. 
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To browse to data to be processed, right-click on an existing collection and select Add
Documents... 

The Add Documents dialogue box will appear:
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Select Import.

Add/Delete Custodians

To modify the custodians in the matter select the Manage Custodians feature from the Settings
menu

To Add/Rename/Delete existing custodians

· Double-click to go into "edit mode". Right Click Custodians to add a "parent level" custodian or
right click on a custodian to add a sub-level custodian. 
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· Right click on an existing custodian to delete. Deleting a custodian will "promote" all
documents assigned to that custodian to the parent of the custodian being removed. If there is
no parent, the documents will go back in to the "Unspecified" custodian

A list of custodians can be added by selecting the "load from file" option. Load a list of "paths" from
a text file to create custodian hierarchies (Use colon ':', back slash '\', or forward slash '/' as path
delimiters)

?

Assign Custodians

The Custodian indicates the author, originator, source, or legal custodian of the documents (for
example, "Ben Blain", "Seattle Network Share", or "Backup Server").

To assign custodians to a collection, or an import within a collection from the process menu, select
the Custodians button to open the Manage Custodians dialog:
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When a default custodian is applied all future imports for that collection are assigned that
custodian. The drop down menu displays the custodians already in use in the matter or select the
Custodians button to add custodians.

In the Manage Custodians window right click on Custodians to add a custodian. See Manage
Custodians  for more detail on organizing Custodians.

To modify or assign a custodian to an import use the Custodian filed on the import in the collection.

54
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To assign a custodian to data at the time of processing, select from the drop down menu which
displays the custodians already in use in the matter or select Manage Custodians to add additional
custodians. 

Viewing Job Progress

The following operations are monitored under the Process Menu>View Jobs. 

· Adding documents and productions (Catalog)

· Generating keyword indexes (Indexing)
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· Generating OCR and extracted text (OCR)

· Converting Native documents to Image (Conversion)

· Endorsing production images (Endorsement)

When a job is in progress a green indicator will appear next to the Process menu:

The grid displays all of the current processing operations occurring in your Matter:

To cancel one or more processing Jobs, right-click on the row(s) of the corresponding Job(s) and
click Cancel Job. 

At the bottom right side of the Jobs screen check the Show Completed Jobs option to show
previously completed/canceled jobs. Clicking Clear Jobs will clear the list of all jobs that are not
currently running. If Auto Refresh is checked, the grid will update the progress and status
information every 5 seconds automatically:
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Migrating Existing Work Product to Digital WarRoom

For client data migrated from another E-discovery platform (i.e. Summation, Concordance or
Relativity) or client data on which a third party has provided data coding, follow the steps below to
load the data into Digital WarRoom:

1. Process the data as you would normally (Adding Documents )

2. In Review, select the collection of interest, right click and select Overlay Metadata. See
Overlaying Metadata  for more details.

You must have a properly formatted .dat load file in order to merge the provided client data,
metadata, and/or coding data. 

Note: If the .dat file you are using has some fields that are not currently setup in Digital WarRoom,
set the new Columns (i.e. Company) prior to using the metadata overlay (see Custom Columns
for information). 

Important: You MUST have a unique key that maps both the data you have just processed and the
.dat file you are using for the metadata overlay (i.e. begbates, id, etc). Metadata overlay cannot be
undone. If you make a mistake, you will need to fix the .dat file and run Overlay Metadata again.

Add Production Documents Referenced by Load Files

Documents produced from eDiscovery platforms are delivered in a format which includes "load

files". These files instruct the database where each document begins and ends.

When documents are produced in this format you will often have a series of folders labeled DATA,

IMAGES, NATIVE, OCR depending on the contents of the production:

22
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The OPT or LFP load file will be located in the DATA folder:

To add documents to a matter, create a Collection:

1. If the production is in a zip or container first extract all files from the container.

2. Select Manage Collections from the Process menu.

3. Right-click on the "Collections" node or an existing collection and select New Collection.

3. A new collection node appears in the collection tree and is editable.
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4. Drag and drop the lfp or opt file onto an existing collection node in the collections tree OR drag
and drop onto the imports grid. The Add Documents interface will appear. 

Imports of data from load files may necessitate the option to de-select "expand containers" if the

data provided by the producing party has containers not intended to be produced as separate

documents. For example, when Excel files have embedded documents which upon expanding

become an unintended produced document without a Bates number.

5. If your DATA folder also contains a load filed labeled as a DAT extension, please see the section on

overlaying metadata: 
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Viewing Exceptions

To review Exceptions that occur during initial Processing, go to Process>Manage Collections and
click on the Collection at issue:

 To see the explanation for the Exception click on the Exceptions tab:

Exceptions can include corrupted files, password-protected files, container files that cannot be
opened, and unrecognized file formats. The following are the major reasons a submission fails:

· There is no access to the disk where the Matter is stored.

· There is no access to the Matter Database.

· The connection to the Matter failed.

· Disk space was exceeded.

· The Matter Database was full.

· A file copy error occurred (the file was locked, password protected, or otherwise
inaccessible).

· The .txt file for the collection was corrupted or missing.

· The location of the documents was not accessible.

· The database timed out because of slow access or slow copying, or because the database
performed too slowly.

Deleting Collections and Imports

From the Process View, click on Manage Collections and right click the Collection to be deleted and
choose Delete Collection...

Important: Deleting a collection will delete all imports associated with it! 
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To delete an Import:

Right click on the Import to be deleted and choose Delete Import...

An analysis of the selected Collection/Import will be completed for produced documents
and reported as those will not be deleted. Only one copy of any given document is stored in
the repository, any files from the repository that are MD5 duplicates of files in the selected
collections will not be deleted.
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 Click Yes to perform the deletion.

Important: Using Delete Files removes the Collection/Import from the Matter permanently. To add
this Collection to the Matter again, the data must be processed again.

The Settings menu is to define and configure:

· Review Policy

· Marks 

· Issue Codes

· Protective Order Designations (PODs)

· Privilege Reasons

· Edit Columns 

· Manage Assignments

· Manage Custodians

· Keyword Lists

· Indexing 

· Custom Print Settings

· Placeholder Images

36
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Review Policy

To modify the documents which appear in review select Review Policy on the Settings menu.

Filter Options

To update review to contain only one copy of each document select "Review unique documents"
and the custodian or collection to which the change will apply.

To place into review all copies of documents choose "Review all copies" for the selected custodian
or collection.

To place into review all documents (no filters including no extension filters) select Pass through (no
filter). This selection will bypass the next step of the policy and place all documents into review.
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Dedupe using:

· Pith: This identifies near duplicates of emails, such as the copies that were sent and
received. The reviewable content for both will be identical (while differing in aspects such
as header and formatting), so deduping by Pith will save you time.

· Forensic Fingerprint: This identifies exact duplicates. If the difference between the sent
and received copies of the same email may be critical enough that they need to be
reviewed separately, for example, use this method.
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Include & Exclude Document Types

These settings customizes Review by the types of files posted:

To edit the default list of viewable document file extensions select the blue Viewable documents
option:

The Viewable Extension dialog box will appear:
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Click Close to commit the changes. To revert back to the default list of viewable file extensions click
the Reset to Default Extensions button.

To exclude certain file extensions from being posted to Review, check the Exclude these file
extensions check box and add a comma-separated list of file extensions in the text box below. To
exclude extension-less documents, check the "Exclude files with no extension" check box.

Important: It is not recommended to post Containers, Binary files, or System files unless absolutely
necessary. Certain file types can trigger changes to the system that are not expected or intend
when viewed in the Document Browser. Use these options with caution.

Date Range

To set a date range, type a start and end date or use the drop down calendar to set the date. This
filter applies to the metadata of the processed document.
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Advanced

Checking the Include previously suppressed documents from Review box under Advanced allows
documents that were explicitly removed from Review AND meet the chosen Policy options to be
eligible for adding back into Review when the policy is applied:
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After choosing Collections/Custodians, Deduping Options, Behavior and Advanced, click Next.

Marks

The overall treatment of a document is designated by the Mark (responsive, non-responsive, etc).
Only one mark selection is available for each document.

Mark options include groups, a sequence number, a type, propagation, and a Protective Order
Designation - POD .

From the Settings menu, select Marks:

group - Marks are grouped together visually for ease of use. Marks with the same group settings will
appear together in the filter and work product trees in Review.

sequence— the order in which the mark will appear in Review. Marks are ordered alphabetically by
the sequence number.

propagate: (on pith), or not propagate.

type:
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· Privileged: For documents with Marks of this type, Privilege Log features are enabled. 

· Produce: Marks with this type identify documents that are candidates for production. 

· Normal: Marks with this type identify documents whose status is other than privileged or
produce. 

Protective Order Designation (POD):

 The default PODs are:

· Confidential

· Attorneys’ eyes only

· Highly confidential

To add a Mark:

Click the Mark field in the row with the asterisk next to it. 

Type in the new Mark.

To change the type of the Mark, select a type from the drop-down lists

To change the POD associated with the Mark, click the existing POD and choose a new POD from the
menu that appears. To add a POD to a Mark, click in the empty POD cell and choose or type the new
POD.

If the Mark should propagate to Pith duplicates when it is applied, check the "Propagate" box; if not,
ensure the box is not selected.

To change the properties of a Mark:
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Click the Mark name to select it.

To change the name of the Mark, overwrite the old Mark name with the new Mark name.

To change the type of the Mark, select a type from the drop-down lists.

To change the POD associated with the Mark, click the existing POD and choose a new POD from the
menu that appears. To add a POD to a Mark, click in the empty POD cell and choose or type the new
POD.

If the Mark should propagate to Pith duplicates when it is applied, check the "Propagate" box; if not,
ensure the box is not selected.

Click Apply.

To delete a Mark:

From the Settings menu, select Marks.

Click the row selector ( ) on the left of the row containing the Mark you want to remove.

Hit the Delete key on your keyboard. The following dialog box will appear: 

 Click Yes to delete the mark.

Issue Codes

Issue Codes are used to identify and categorize documents. 

From the Settings menu, select Issue Codes:
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Under the CODE column enter the desired Issue Code. This Code is up to four characters (letters,
numbers or special characters). In the ISSUE column describe the Code. Issue Codes with the same
GROUP settings will appear together in Review. Issue Codes are grouped together visually for ease
of use. In the PROPAGATE column check the box to propagate the Issue Code to Pith duplicates.

To add an Issue Code, click the Code field in the row with the asterisk next to it. Enter a Code, Issue,
Group, and decide whether the code should propagate to duplicates.

To edit an existing Code, Issue, or Group, click the appropriate field to select it and replace the
existing value with a new one. 

To delete an Issue Code, click the row selector box ( ) to the left of the row you want to remove
and hit the Delete key on your keyboard to get the Delete Record dialog box:
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Click Yes to delete the Issue Code. 

When you have made the desired changes, click Apply.

Protective Order Designations (PODs)

A Protective Order Designation (POD) explains the level of confidentiality of a document. To add or
modify an available POD from the Settings menu select PODs (Protective Order Designations) 

The PODs dialog box will appear in which POD can be added or modified. Click on the + row to
create a new POD.
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To change the name of a POD, click the name and overwrite it.

To add a POD, click the asterisk (*) in the last row (this highlights the new row) and type the name
of the new POD in that row.

To delete a POD, Click the row selector ( ) on the left of the row to be removed and select the
Delete key on the keyboard.

Click Yes to delete the POD.

When the desired changes have been made, click Apply.

Privilege Reasons

To configure available privilege log descriptions indicating why a particular document has been
marked with a privileged-type mark, from the Settings menu select Priv Reasons:

The Privilege Reasons tab shows the available reasons for privilege.
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To add a new Privilege Reason, click the TITLE field in the row with the asterisk next to it, type in
the new privilege reason, and provide values for the SEQ and TXT fields.

To edit a Privilege Reason, overwrite the appropriate fields with new values.

To delete a Privilege Reason, click the row selector box to the left of the row and hit the Delete key
on the Keyboard to see the Delete Row dialog box and confirm.

To edit the Privilege Types select the Types tab and add, edit or delete privilege types with the
same steps from above.

Click Apply to commit the changes.

These options are also available for the Priv Basis
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Edit Columns

Each column available for view has an impact on overall database performance as each must be
accounted for during each search. The fields which are available to be displayed in the grid screen
impacts the speed at which the results will be returned. See Advanced Options  for
ALLCUSTODIANS and BATES which have the most dramatic impact on performance.

To modify the default columns available in Review and Produced select Settings - Edit Columns:

Select the view of the tool to modify and select or deselect columns as desired by checking or un-
checking the corresponding box to the left. 

Click Apply to commit your changes.
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A check mark indicates this column will appear in the grid screen until a user removes it from the
view. A gray box (clicking the box twice) indicates this column is available on the field chooser but
does not appear automatically in the grid screen.

Custom Columns

To add Custom Columns go to Settings and choose Edit Columns:

Select the third tab - Custom Columns:

Right-click in the dialog box to add,delete, or edit columns and the drop down menu will appear:
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The Add/Edit Custom Columns dialog box will appear:

Type the name of the new column into the Column Name area.

Choose column type from the drop down: 

Text -- use for fields that may contain symbols and/or alphanumeric characters 

Text (Long) -- use for fields that may contain > 2000 characters of text

Number -- use for fields that only contain integer data

Date

Choose either Locked for editing or Filterable:
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The Locked for editing option specifies whether this field should be editable by reviewers.
Individual cells in a locked column will not be editable, however, metadata is overlaid into a
"locked" Custom Column.

The Filterable option specifies whether the unique values in this field should be visible as filter
options in the filter tree. After enabling the Filterable option for a Custom Field, go to Matter ->
Refresh Environment to see the filter option appear. Likewise, changes to the values in that column
will not be reflected in the filter tree until the environment is refreshed.

Click Apply to commit the changes.

Important: When using the Filterable option, only the first 1000 unique values in a field will be
added to the filter tree.

Advanced Options

The last tab in Edit Columns accesses the Advanced Options.

· All Custodians - when a discovery order requires the export of an "all custodians" field, enable
this column. The tool will then update the field to include the Custodian assigned to each
duplicate of the document. See Manage Custodians  for assigning custodians to collections.
Because custodians can be modified at any time, this field is calculated and updated with each
search and will take resources for each search result.
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· Bates column - this column will display the beginning and ending bates number for each
document produced though the DWR process or loaded into the matter by a load file. Because
this data can be modified at any time this field is calculated and updated with each search and
will take resources for each search result.

Manage Assignments

To create Assignments select that option on the Search button drop down. The documents which hit
on the current filter selection will be added to individual assignments based on the selected size.

Note: A document can be in only one Assignment. 

The Create Assignment dialog box will appear:

The assignment size will vary as the documents are first segregated for the assignment and then the
family members are added to the assignment. 
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To rename an assignment select Manage Assignments and double-click the assignment name. Type
the revised name.

To delete an assignment set click on Manage Assignments and highlight the assignments to be
deleted. Click Delete on the keyboard, confirm and select close.
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Manage Custodians

To modify the custodians in the matter select the Manage Custodians feature from the Settings
menu

To Add/Rename/Delete existing custodians

· Double-click to go into "edit mode". Right Click Custodians to add a "parent level" custodian or
right click on a custodian to add a sub-level custodian. 

· Right click on an existing custodian to delete. Deleting a custodian will "promote" all
documents assigned to that custodian to the parent of the custodian being removed. If there is
no parent, the documents will go back in to the "Unspecified" custodian

A list of custodians can be added by selecting the "load from file" option. Load a list of "paths" from
a text file to create custodian hierarchies (Use colon ':', back slash '\', or forward slash '/' as path
delimiters)
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?

Keyword Lists

Select Settings - Keyword List to manage multiple sets of keyword search terms which can be used
when:

· Using Keyword Analysis

· Bulk Marking

· Viewing documents in the Highlighted tab of the Document Browser

To add/change/delete a Keyword List:
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To add a new list: Click New List. This will create a new list to which keywords can be added.

To rename an existing list: select the list to rename. Click on the name of the list (or hit F2).
It will become editable. Change the name and hit return or Tab to commit the change.

To delete a list: Select the list you want to delete. Hit the Delete list button.

To add/change/remove keywords to the selected list:

With a list selected, the Keywords grid will enable. To add keywords to the selected list:

o Import keywords from a text file using the Load from file option. Browse to a text file
and import the keywords (one search expression per line) into the keyword list. Long
lists may not import in their entirety and an indication as to the last term imported
will be displayed.

o Paste keywords (one search expression per line) into the keywords grid from Excel or
a plain text file.

o Add words individually by clicking the field to the right of the row with the asterisk.
After adding a search expression, hit the Tab key to commit the change.

To edit existing keywords select them and type in the selected field. Hit the Tab key to
commit the change.

To delete one or more keywords by select the rows to delete and hit the Delete key on the
keyboard.

Indexing

Choose indexing options, configure the "noise" or "stop" word list, and the list of file extensions
excluded from indexing select Settings - Indexing.

Use the Options tab Rebuild Index or Sync Only:

Check the Rebuild index check box to completely rebuild the indexes in your matter. Re-indexing
the matter without Rebuild index checked will examine all documents in the index but will only
index new or modified documents.
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To manage the "Noise Words" list:

The Noise Words list is used to exclude certain common words from being indexed. Excluding
certain very common words has the benefit of increasing keyword search performance as well as
the amount of disk space required to store the keyword indexes.

Select the Noise Words tab.
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Add words to the list by typing the word into the row at the top of the word list next to the *
symbol. 

Remove noise words by selecting the words to remove and hitting the Delete key on your
keyboard.

To restore the noise word list to the default list, click the Restore Defaults button.

Import an existing list of noise words from a text file using the Import… button.

Export the noise word list to a text file using the Export… button. 

Click Apply to save your changes.

Note: Altering the noise word list requires that existing indexes be re-generated before the
changes will take effect. 

To manage the file extension exclusion list:

Select the Excluded Extensions tab.
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Add extensions to the list by typing into the box at the top of the list next to the * symbol.

Remove extensions by selecting the rows to remove and hitting the Delete key on the
keyboard.

To restore the excluded extension list to the default list of extensions, click the Restore
Defaults button.

Import an existing list of extensions from a text file using the Import… button.

Export the extension list to a text file using the Export… button.

Click Apply to save the changes.

Note: Altering the Excluded Extension list requires that you re-generate any existing indexes
before your changes will take effect. 

Custom Print Settings

To specify production-related settings on a per-file-type basis go to the Settings menu and select
Custom Print Settings.

Based on file extension, printing is configured as follows:
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· The application to be used when attempting to "print" native files (i.e. to render images of
native files). If an extension does not have a custom print setting specified the OS default
application will be used when attempting to image files with that extension. 

· The amount of time to wait for a document to be printed.

· To produce all files with that extension as Native files instead of images.

· Which color print settings to use when converting that extension.

Important: It is not required to customize these settings. Only modify them if the default/current
associations are not satisfactory. 

To edit Custom Print Settings:
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Use the Timeout tab to change the timeout value (in seconds) for file types that may take
too long to print. 

Use the Color tab to choose from the set of image color options. 

Use the Native tab to designate certain file types to be produced as natives by checking the
box in the Native column.

After making the desired changes, click the Apply button to have them take effect.

Restore the default Extensions, Timeouts, and Applications by clicking Restore Defaults
button.

Placeholder Images

Placeholder Images are automatically placed for any document in the Production that is marked
Native, Withheld or Clawback.
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Choose to Produce a document as Native by right-clicking on the document in the Current Docs grid
screen and hovering over Produce as... and then choose Native:

Modify Placeholder Images:

Placeholder Images are modified in two different scenarios: globally (all productions in the matter
will use the custom images) or for a specific production.

From the Settings menu, select Placeholder Images:
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Choose the type of placeholder to replace (Native, Withheld, or Clawback):

Click Replace and browse to the replacement image on the computer. 

Click Open. The image will update to the replacement Placeholder Image. 

Clicking Restore Default for any of the placeholder images will restore that image back to the
corresponding image above.

To customize placeholder images for a specific production only and not the entire matter, see
Production Placeholder Images - Customize  for details.

The Analysis tools are a critical part of the e-discovery process enabling quick analysis of the size
and composition of the Matter. With the extensive amount of metadata available for each
document, tools are available for complex filtering combinations at any point during the course of a
Matter.

 The Analysis tools provide a way of trying out various combinations of document characteristics to
see which combination will be most effective and efficient:

· Keyword Analysis

· Who to Whom

· Tabulate

· Thread Visualizer

· Date Histogram

· Reports
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Keyword Analysis

The keyword analysis tool generates a report on an existing keyword list across a set of documents. 

Filter for the desired set of documents and select keyword analysis from the tools menu.

Select a keyword list.  To create a new list click Manage Lists and see Keyword Lists

Select the aggregate option for the keyword hit counts by Custodian, Collection, Mark, Binder,
Assignments or Review - no aggregating.

Applying stemming rules to keywords adds grammatically related words (apply/applies/applied) to
the report. Selecting Heat Map will color code the results based on the number of hits.

Click apply to execute the searches and aggregate the results. The time to complete the search and
display the results in the grid is dependent on the number and complexity of the terms.  Terms
containing wild cards extend the time to display.
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To see the documents that hit on a given keyword/custodian pair, double click on the cell containing
the number of hits. The Current Docs grid screen will update to filter on those documents. 

To export the results to an Excel file, click the Export button. Choose a save location and file name.
For subsequent searches, the export will log them to the same Excel spreadsheet by clicking Append
to previous export without having to specify the location and name again.

Who to Whom (About What)

The Who to Whom analysis interface provides information regarding email exchanges and is
available from the Analysis menu.

Once selected a table appears with all the From names for these custodians/collections as column
heads (up to 50), and all the To names (including CC and BCC recipients) as row heads. If necessary,
scroll to the right to see the entire table.
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To see the specific documents that two people were in communication about, double click on the
cell containing the number of documents. The Current Docs grid screen will update to show those
documents.

To Export the result table to Excel, click the Export button and navigate to an appropriate location,
type a file name, and click Save.

· Each cell displays the number of unique communications between the two
correspondents. 

· If both SENT TO and SENT FROM are empty, it is ignored, but if only one is empty, it will
show up as a single communication. 

· An email that was sent from an individual to three other individuals appears as one unique
communication in each of the three cells. 

· A communication collected from four email boxes and addressed to three individuals
appears as one unique communication in each of the three cells. 

· The numbers in the cells show the number of conversations between the To and From
names. The largest numbers are highlighted with color.

Tabulate

Tabulate creates a table of available fields from the filter set and is available on the Analysis menu.

After running a search of data select Tabulate. Using the drop downs, choose to aggregate document
counts based on one item from the left drop down and one from the right drop down:

If a field does not appear on the drop down go to Settings - Edit Columns and check that column on
for review.

After selecting the options from the drop downs the grid displays the tabulated information. Color is
used to quickly identify the largest values.
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To see the specific documents that are represented by the number in any given cell, double click on
the cell containing the number of documents. The Current Docs grid screen will update to show
those documents. 

To export the result table to Excel, click the Export button and navigate to an appropriate location,
type a file name, and click Save.

Thread Visualizer

Individual emails are often part of a thread of communications—replies, replies to all, and
forwards, with extra recipients added or deleted. 

The Thread Visualizer creates a visual representation of the "chain" involved in each email. The
chronology of the email conversation is reconstructed by looking at each of the emails in turn. The
Thread Visualizer gathers them all and displays their original order. The first email in the thread is
highlight in orange.

To use the Thread Visualizer:

1. Run a search in Review that returns email documents.

2. Select an email document in the Document List.

3. From the Analysis menu, select Show Thread Visualizer:

The Thread Visualizer dialog box will appear:
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4. The layout of the thread can be changed by selecting Timeline (shown above) or
Network. The Network layout displays how emails would have appeared in the network
of the exported system (shown below).
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5. The green plus, minus, and arrow icons at the top of the window will allow you to zoom
in, out, and fit to window.

Please Note:

· To view individual emails within the thread, click the block representing the email. The
document for that stage of the thread appears in the Current Docs grid scree. The row in the
Current Docs grid screen where that email is listed is also highlighted.

· Sort on the column "Thread Group" in the Current Docs grid screen to cluster emails from the
same thread. 

· Only those emails that are in the Current Docs grid screen will be highlighted and visible in the
Document Browser.

· It is possible that some parts of a thread may not exist in your Matter because you do not have
data for one of the custodians involved in the conversation thread. The missing messages will
appear as a gray box in the visualizer with the text "<Missing>" (as seen in the screen shot above).

Date Histogram

The Date Histogram function can help to quickly identify if there are missing documents in a
particular date range as well as give a sense for the volume of information by time.

1. Perform a search in Review. The Date Histogram tool operates on the results that are
returned from that search and from the Analysis menu select Show Date Histogram:
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2. Use the Years and Months options to change the display. 

Reports

This function is available on the Analysis menu

Reports allows for the generation of reports on various aspects of the data collected, reviewed and
produced. Some reports like the Privilege Log and Cost to Review Calculator are interactive. All
reports can be exported to Excel. 
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Access the following within the Tools tab :

· Toggle Row Filters

· Work Palette

· Exporting Grid

· Export Documents

· Work Inspector
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Toggle Row Filters

When this option is selected the Current Docs Grid screen becomes filterable where each heading
in the grid can further be filtered in the resulting search.

Work Palette

To assign a Mark, Issue Code, or Comment to a group of documents using the Work Palette under
Tools:

Click on a group of documents in the Current Docs grid screen, then click on the Work Palette button
to open the Work Product Palette dialog box:
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Check the box for the appropriate Mark and Issue Codes or add a Comment and click Apply. 

To remove Marks from all selected documents by selecting the Unmark check box.

To delete certain Issues Codes from all selected documents, select the Delete radio button, then
check the Issue Codes to be remove.

Exporting Grid Metadata

To export the Current Docs grid screen to a file run a search to populate the Current Docs grid screen
with the information to be exported.

NOTE - the columns currently displayed in the Current Docs Grid screen are the columns that will
appear on the export.

Next, from the Tools menu, select Export Grid or type CTRL+M:

The Export Grid dialog box will appear:
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Choose the Export Options (Excel or tab-delimited).

Browse to the location where to save the export file using the Browse... button and select Export. 

The export location will be automatically opened when the export completes.

Exporting Documents

First run a search to populate the Current Docs grid screen with the information to be exported. To
export a binder, execute a search to load the binder.

Note - To only export a subset of the documents in the Current Docs grid screen, select the rows to
be exported. If nothing in the grid is selected, all documents in your search result set will be
exported.

Next from the Tools menu, select Export Documents or type CTRL+E:

The Export Documents dialog box will appear:
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· Destination - Browse to a folder to export the documents using the Browse... button.

· File name Format - When exporting documents, it is highly encouraged to consider the
naming convention so that documents can be cross referenced between the exported file
names and the database. The File name Format determines the exported document
names:

o Document Sequencing: Select "Sorted Sequence #" in the left most drop down to pre-
pend a sequence number to the document file names that matches the current sort
order of the document list. This action allows the exported documents to sort in the
same order currently displayed in the Current Docs Grid. 

o File name: Using the required middle drop down, name files with their original titles
(TITLE), the document IDs (ID), the Bates numbers (BATES), or the control or XREF
number (CONTROL#). When the Bates or Control# options are selected and the files do
not have Bates or Control Numbers, ID naming format will apply.

o POD: When saving produced documents, to include the Protective Order Designation
(POD) in the exported file name, choose the POD option from the right-most drop down.

· Export As - Choose the format of each document exported:

o Natives - the document format as it was originally processed into the system (.msg, .doc,
.xls, etc.)

o Images (where exist, else Native) - imaged versions of each document and if a
document is not yet imaged the native version will be exported.
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o Images as PDF (where exists, else Native) - PDFs of the imaged version of each
document and if a document does not have an image, the native version will be
exported.

o Emails as HTML (everything else Native) - MSG/EML files in an HTML form that can be
viewed using a web browser. All other files will be exported as natives.

Important: When exporting produced documents that were produced as type "Native",
even if choosing one of the "Images" options, the native file will be exported instead of
the placeholder image.

· Include - Optionally include OCR/Extracted text where available and/or RTF formatted
Slipsheets containing metadata about each exported file.

After making these selections click Export. The export location will be automatically opened
when the export completes.

Included with the document export will be a "manifest" index.html file containing all of the
currently visible Document List columns as well as Bates numbers and hyperlinks to the exported
documents. 

Important: Make sure to remove columns from the Current Docs Grid that should be
excluded in the manifest file prior to exporting the documents.

Replacing Documents in Review

Important: Replacing a document has several far-reaching consequences including:

· The MD5 fingerprint in the database will remain the MD5 for the ORIGINAL document NOT
the replaced doc.

· Mark propagation will therefore not work on the new document (it will propagate based
on the old document fingerprint).

· The new document will not return in keyword searches until the document or collection is
re-indexed.

· The original document cannot be recovered without re-processing the original collection
and re-posting.



77Chapter 8 Tools

8Tools

Select Replace Documents from the Tools menu.

Select the version of document to be replaced:

· Native document – this is the document seen on the Native tab of the Document Browser
and originally processed 

· Pre-production Image – this is the un-endorsed tif image that seen in the image tab before
it is endorsed

· Produced Image – this is the endorsed image in a finalized production

· OCR – this is the text associated with the document

After uploading the documents to be replaced to a location accessible to Digital WarRoom, browse
out to the folder holding the documents to be replaced:
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The tool will identify possible matches for each document in the selected folder. The title of
the source file (file to be added to Digital WarRoom) must match on a Digital WarRoom ID or
Bates Number. Replacements for native files must also match on file extension. 

Check the items to be replaced.

Shaded rows indicate source files which failed to match documents in Digital WarRoom.
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Confirmation of this action is needed before proceeding.

Work Inspector

To view work produced assign or apply a Mark, Issue Code, or Comment to a single document at a
time use the Work Inspector under Tools:

Click on a document in the Current Docs grid screen, then click on the Work Inspector button to
open the Work Product Inspector. Check or uncheck the appropriate Mark, Issue Code(s), or add a
Comment.
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The Propagate comment to duplicates (will overwrite) check box at the bottom of the Work Product
Inspector (see above) refers to the information added in the "Add comment here" box only and
does not impact the Mark or Issue Code(s) applied. 

Note: Documents can have only one Mark but may have multiple Issue Codes. Comments are
automatically saved.

In Review electronic documents are analyzed and decisions captured about those documents in a
shared, easy-to-use environment.

Use Review to do the following:

· Make the document review process faster and more efficient by reviewing documents in
native format (no need to convert documents before looking at them)

· Capture attorney work product (Issue Codes, Marks, Comments, Privilege Log
designations, redactions, etc.)

· Search for documents using metadata as well as document text

· Make necessary preparations for production

· Add metadata to collections you have added to review via a load file

When in the Review View the word Review is in bold under Find Documents. 
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Strategies for Effective Review

Email and other electronic documents contain embedded information, commonly referred to as
"metadata" or "embedded data." Electronic documents carry their history with them in this form.
Email metadata can include information about when an email was created, as well as any
attachments it originally contained. This data can have important evidentiary value in settling
factual disputes regarding a document’s source and history. Before producing documents,
reviewers need to be aware of, and prepared to handle, any metadata that might help or harm their
legal strategy or a client’s position.

Using Review, the following is availalbe:

• View documents in various formats

• Automatically Mark and Issue Code duplicate documents
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• Perform keyword searches

• Filter documents based on metadata embedded in the files

• Redact documents

Review is used to apply Marks, Issue Codes, and Comments to documents in the database. By
default the tool is set to only apply these decisions once; they are automatically propagated to any
duplicate documents. (The exception to this is any marking categories which have been set not to
propagate.)

Instant updates of decisions can be viewed by all attorneys involved in a review. This prevents
multiple reviewers from classifying documents inconsistently, and it gives reviewers an easy way to
record the reasons a decision was made.

Review tracks all reviewer decisions in a log file in the History tab, making it easy to go back later
and see when and by whom a decision was made.

During processing, a unique electronic identity for each file in the database is generated. This
creates a 128-bit value that serves as the document fingerprint. This fingerprinting process,
substantiated through case law, ensures that two documents with the same fingerprint are in fact
identical. 

When documents need to be produced, Review makes it easy to examine reviewer decisions,
redact sensitive information before production, and organize documents using Binders. In addition,
attorneys can identify conflicts (such as a document marked for production that contains
attachments marked as privileged).

Keyword Indexes

Indexes of words and numbers contained in documents are created so they can easily be searched. 

Documents are automatically indexed upon being posted to Review. However, there are a few
situations where re-indexing is necessary:

· After generating OCR text

· After replacing native documents or OCR text for specific files

· After software updates

There are several ways to manually initiate the keyword indexing function:

· By right-clicking on the Collection in the filter tree and selecting "Re-Index...":
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· By right-clicking one or more selected documents and selecting "Re-Index...":

To monitor the progress after selecting one of these options go to the Process tab and select the
View Jobs interface. A green indicator will appear by the Process tab while a job remains in
progress.
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Generating OCR/Searchable Text

The OCR function generates text of images and PDF documents. Several features use this generated
text such as: 

· Keyword searching

· Productions

· Predictive Analysis (Gist)

For the generated text to be available for keyword searching the data must be re-indexed to add the
newly generated text files to the index.

To access the OCR functions:

· Right-click on the filter tree and select "OCR..."

· Right-click one or more selected documents and select "OCR..."
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In the OCR dialog choose whether to replace existing OCR or Extract text from PDFs selecting click
Run to start the OCR process. Always replace the OCR after redacting documents. 
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To monitor the progress go to the Process tab and select the View Jobs interface. A green indicator
will appear by the Process tab while a job remains in progress.

The "OCR" column in the Document List will indicate whether or not a document has OCR. The
Document Browser will contain an OCR tab for all documents with OCR.

Any errors that occur when generating OCR/extracted text while in the Process View will be logged
and can be viewed on the Exceptions tab after processing completes.

On the Advance tab the OCR engine can be optimized for a particular language:
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Filtering and Searching Documents

The Review filter tree is on the left side of the screen. The various filters are used to determine
which documents to review. Once filter choices are selected and the Search button is selected the
documents will be listed on the Current Docs grid screen to the right:
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The search summary above the Document List displays the current search parameters:

Once a search is complete, the results will appear in the Current Docs grid screen.

The Search Button

After choosing filter criteria clicking Search will execute the search. To include family members
with the search hits, click the drop down menu to the right of the Search button and select Search
with Families. Likewise Search with Threads will return thread members of search hits. 

The selected filter criteria can also be saved as a Saved Search with a selection on the Search
button.

The resulting set of documents can also be placed into Assignments 122
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Searching by Attribute

In Review documents can be filtered using the various attributes available in the filter tree:

Once attribute(s) are chosen, select the Search button to execute the search. The resulting
documents will appear in the Current Docs grid screen.
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Assignments/Binders/Custodians/Collections

Select the check box(es) next to the Assignment or Binder or Custodian or Collection that you want
to search. Click on the Search button to execute the search.

IDs

To filter by document ID, check the box next to the IDs filter tree node. Enter a comma separated
list of ID values to filter on multiple IDs. The IDs filter option also allows searching for a range of ID
values (i.e. "100-200" would return the range of IDs between 100 and 200).
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Bates numbers

In the Bates Range check box, type a comma-separated list of numerical values (for example, 3, 56,
478) and/or ranges (for example, 45-267) to search for. The tool automatically adjusts for the bates
pad thus the leading zeros is not required. 

To limit the Bates search to a specific Bates prefix, select the appropriate prefix. 
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Marks

To expand the Marks search criteria, click the arrow next to the Marks icon:

Included: Placing a check in Marks will search for all Mark types and those documents will be
included in the Current Docs grid screen. In the example below, all documents with the Mark
of Privileged will included in list of documents in the Current Docs grid screen: 
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To exclude documents with the Mark/Issues the search results, click the box a second time.
In the example below, all documents with the Mark of Privileged will be excluded from the list
of documents in the Current Docs grid screen:

Issues

To filter by documents with certain Issue Codes expand the Issues search criteria, click the arrow
next to the Issues icon:

· Included: Placing a check in Issues will return all documents assigned to that issue into the
Current Docs Grid Scree. 
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· Excluded: By double clicking an issue code all documents assigned that code will be
excluded from the Current Docs grid screen. (If Search With Families is selected the family
members returned in the filter results may have the excluded codes)

· As documents may have multiple issue codes an option is available to choose Any or All
for the selected codes.

File Extensions

To filter by File Extensions go under More Filters:

Check the box(es) next to the extension(s) to be returned in the filter set. The count next to each
file extension shows the number of documents matching that extension. 

Note: The "email" extension filter is a special filter that will return all MSG, EML and other email file
extensions with a single search.

To filter by Extensions, check the box(es) next to the redaction state(s).

· Included: Click the box to place a check in an Extensions box to search for and include all
instances of that Exension(s).

· Excluded: double click to Extension(s) 
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Date Range

To filter by Date Range go under More Filters:

Under More Filters, select the Date Range check box, then type a start date and/or end date in the
appropriate fields. 

The From date defaults to the date of the oldest document in Review, and the Until date defaults to
the date of the most recent document in Review. 

For either of the two fields, clicking the drop-down arrow brings up a calendar which can be used to
specify a date. Use the forward and back arrows to choose the month/year, and then click the
specific date within that month:
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File Type

To filter by File Type go under More Filters:

To filter by File Type(s), check the box(es) next to the File Types(s).

· Included: Click the box to place a check in a File Type(s) box to search for and include all
instances of that File Type(s).

· Excluded: If you click the box again, documents with that File Type(s) are excluded.

Redaction State

To filter by Redaction State go under More Filters:

To filter by Redaction State(s), check the box(es) next to the redaction state(s).
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Reviewers

To search for all documents last Marked by specific Reviewers, use the Reviewers filter. Reviewers
who have accessed the database but have not Marked any documents will show up under
Reviewers in the Filter Tree with no number after the name:

(In the example above Alison has Marked one document. Cwaterman and Paulette have not Marked
any documents.)

NOTE: You must have the Reviewer column currently in the Current Docs Grid Screen in order to
search by Reviewers. See Settings>Edit Columns

If you do not have the Reviewer column in the Current Docs Grid Screen and you search for Reviews
you will see the following:

Production Flags

To filter by Production Flags under More Filters:

 Select the check box(es) next to the Production Flag to be returned in the filter set and appear in
the Current Documents Grid.

Custom Columns

Custom Columns can be designated as "filter" fields (see Custom Columns ). Those fields will
appear in the filter tree under "Custom Columns". The top 1000 unique values in any given
filterable Custom column are added to the custom column filters. 

48
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Custom Fields with more than 1000 unique values in them are not good candidates for filtering.

Special Filters

 

· Unindexed files – Filters on files that do not contain indexed text and are therefore
excluded from keyword types of searches. Unindexed files display in blue text in the
document list.

· Files without OCR - These are files that have not been through OCRing which creates an
exportable text file for those that are indexed and generates text for documents which do
not have exportable text.

· Families with mark conflicts – Search using this attribute to ensure documents do not
include conflicting marks. For example, a relevant email with a privileged attachment
should be checked to address the decision of whether to "break" document families
whose members have different marks when producing them.

· Duplicates of privileged documents – Returns all duplicates of documents with privilege-
type marks.

Advanced Searching

The Advance option is available to search the fielded data extracted during processing.

In the Filters box, click on the Advanced option in the drop down menu:
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Choose a Field from the available options. These fields map to the columns that display in
the document list. Only those Field names listed in the drop down are available for
Advanced Searching. 

In the box to the right of the Field, click the relevant operator (such as Contains or Starts
With) from the drop-down menu. 

In the Value field, type a string for the value to search and click Add. The Value appears in
the Current Conditions field.

To search for another value, repeat steps 1 to 3. When more than one condition appears in
the Current Conditions field, the Boolean connectors (AND, OR, etc.) become available on
the left. 

Click any of the Boolean connectors to set logical conditions for the values in the search.

Click Search to execute the advanced search.

Note: To use pith values or ID numbers as search criteria, the Copy Value function makes it easy to
copy and paste these without introducing error. Right-click the appropriate cell, click Copy Value,
and press Ctrl + V to paste the value into one of the Advanced search boxes.



100 Chapter 9 Review

9Review

Saving Searches

To save entire sets of filter and keyword search criteria use the Save Search... feature. Searches are
saved in the database and are available to all Reviewers.

To save a search:

Select all of the filter/keyword criteria to be saved.

Click the down arrow to the right of the Save Search button to show the search options and
choose Save Search...

Enter a descriptive name for the search. Click Save.

To recall a previously saved search:

Select Saved Searches from the Filters drop down:
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 The list of Saved Searched will appear at the top of the Review view:

 Select the search to be applied. Click Run Search. Double-click the search to be applied.

All of the criteria in the filter tree will be changed to match the criteria specified by the
Saved Search.

Note: It is possible that recalling a Saved Search will return a different number of results than the
first time the search was run. This may happen if the Review corpus is changed (documents
added/removed) after the search was initially saved.

Searching by Keywords

Use the Keywords box below the filter tree to search for documents that contain particular words or
phrases. This type of search applies only to documents within the currently selected scopes (that is,
the currently selected filter tree items).
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The simplest way to search is to type a word or phrase in the "Paste or type keywords here" field
and click Search. If the search is successful, documents containing the keyword(s) appear in the
Current Docs grid screen.

Use Boolean operators to narrow your searches. For a guide to building effective keyword searches,
see Appendix A – Building effective Keyword Searches .

Check the "Stemming" box to search for common variations of the root word. Examples: fire, firing,
fired,fires.

In the Current Docs grid screen, click any one of the results to see the full text document in the
Document Browser. 

In the Document Browser, click the "Highlighted" tab to show the keywords for this particular
search stand out in the text. Then click the blue keyword links at the top of the document to move
to the first instance of the keyword(s). The number displayed to the right of the blue keyword is the
number of times that keyword appears in the document. The blue chevrons around the highlighted
words will take you to the next or previous highlighted word.

The result might look like the following:

193
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Keyword Lists

Pre-defined Keyword Lists, are available as options in the Keyword Lists section of the Keywords
filter. Checking a list will search for all keywords in that list.

Clicking Manage Lists will open the keyword list management interface. See Managing
Keywords  for more details.

To see all keywords in a pre-defined Keyword List highlighted on the Highlighted tab, select a
Keyword List from the Keyword Lists drop down. When searching for ad-hoc search terms and a
keyword list is selected, all words in the list plus the terms in the ad-hoc search are highlighted. In
the example below, all terms in the Keyword List titled "Responsive Terms" that exist in the
selected document(s) are highlighted.

55
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Save results to...

When filtered results need to be added to a binder or production hold down the CTRL key while
clicking on the Search button:
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From this menu select to which binder or production the filter results should be added.

Right click on the Binders to create a new binder:
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After creating the New binder select that binder for the filter results to be added:

Right click on Draft Productions to add to a new production



107Chapter 9 Review

9Review

After creating the new production it must be selected for the filter results to be added:

The Document Browser

In the Document Browser displays documents in their Native format (the default), or in a special
Highlighted format that makes keywords stand out, as Imaged, or by the History of the actions
associated to the document.

 

Native

The first tab in the Document Browser is the Native tab:

Native is the format used by the application that created the document. (For example, when you
create a document in Microsoft Word creates a DOCX file.)
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Highlighted

The second tab in the Document Browser is the Highlighted tab:

The Highlighted tab shows keywords within the documents after performing a Keyword Search:

 Documents that contain the keyword(s) will appear in the Current Docs grid screen. Click on one of
the documents in the Current Docs grid screen and the full text of the document will appear in the
Document Browser. The Highlighted tab will now appear in the Document Browser window.

At the top of the document, click the <<first hit>> link to jump to the first keyword. Use the double
arrows to navigate to the previous (<<) or next (>>) occurrence of the keyword. Here we have
searched for the word "protect":
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 If you include family members, documents marked with the Filter Mismatch Indicator ( ) are
included in the list panel because they are part of a document family and not because they meet
the filtering criteria; therefore, they do not include any keywords related to your search and will
not display hit highlighting:

Note: The text of an un-indexed document cannot be keyword searched and will not display
highlighting on the Highlighted tab, even if it is an image created from text (such as a Word
document made into a .TIFF file or a .PDF file).

Important: There may be metadata or other hidden content that is searchable but not viewable in
the browser. 
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Image

The third tab in the Document Browser is Image:

This tab displays after you have imaged the documents creating a TIFF image.

History

The History tab on the Document Browser displays all work product decisions made, by whom, and
when affecting the currently selected document:
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Viewing Multiple Documents

Selecting the  icon in the document browser to open multiple browsers. 

The next row selected from the Current Docs screen will load into the new browser. The browsers
can be undocked and moved side-by-side to compare documents.
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Current Docs Grid Screen

Documents that meet search or filter criteria appear in the Current Docs grid screen.

The top of this panel displays attributes of the current result set: document count, page count, and
the filter options that were used:

 An explanation of any column headers is displayed when hovering over the column header until
additional text appears. Here hovering over the PATH header opens the box describing the column -
Original document location:
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Adjusting Font Size

Ctrl+Mouse Wheel to change the font size in the grid. Matter - Reset Layout will return to the
default size.

Normal:

Adjusted Larger:

Changing the Column Order

To set the columns which are available by the Field Chooser and set as the default see Settings -
Edit Columns .

To change the order of the field columns(FAMILY, ID, THREAD GROUP,etc.) drag the header to the
desired location and drop it there.

Note: Changes to Column order and Current Docs Grid Screen layout impact only your ID and will
remain set until you change them. 

To pin a column to the left, click the thumbtack in the field name, as shown in the figures below;
the column moves as far as it can before it encounters another column that has been "pinned." Click
the thumbtack again to "unpin" the column again, so that other columns can be placed to its left.
You may also know this function as "freeze column"

For example, in the below screen shot, the column "Family" is unpinned:
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After clicking on the pin icon, the column "Family" an be pinned to the near or far edge of the
Current Docs Grid Screen:

An individual user’s column settings can be set to the defaults by selecting Matter -> Reset Layout
from the Matter menu:

Changing the Sort Order

To sort documents according to a particular field column, click the column header at the top of the
screen; click it again to reverse the sort order. 

To sort multiple fields hold down the CTRL key and click the column headers.

Field Chooser

To choose which columns to display, click the Field Chooser  icon at the top left of the Current
Docs Grid Screen:

 OR right-click any column header:
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Select Show Field Chooser and check/uncheck columns from the list that appears. 

The field chooser will edit the columns displayed locally. 

Column Displays….

File icon File types with traditional document associations for common applications
such as Microsoft Word, Excel®, and Adobe PDF. Emails have an envelope
icon. 

Note: Be aware that installing software that alters the file extension
associations for a given file type may change the icons for those file types.

Filter mismatch
indicator

Documents that did not meet filter criteria but are included because they are
family members of a document that did meet the criteria.
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Column Displays….

Privilege Flag Flag Colors:

Red = Privileged

Grey = Clawed back

Production Flag Flag Colors:

Green = The document is in a draft production

Blue = The document has been produced

Yellow = A duplicate of the document has been produced

Purple = A family member of the document has been produced

ALLCUSTODIANS
A semi-colon delimited list of all custodians that have a duplicate of this
document

ASSIGNMENT Name of assignment containing the document (if any).

AUTHOR The author of document (Microsoft Office documents only)

BATES A semi-colon delimited list of all Bates numbers assigned to the document

BCC Email BCC recipients.

CC Email CC recipients.

COLLECTION Name of document's associated Collection.

COMMENT Any comments entered by reviewers.

COMPANY The company of document (Microsoft Office documents only)

CREATED The date the instance of the document ingested was created. 

CUSTODIAN The associated custodian to that document.
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Column Displays….

DATE The last-modified, received or sent date associated with the document.

DESCRIPTION The document description (Microsoft Office documents only)

DOCTITLE The document title (Microsoft Office documents only)

ESTIMATED
PAGES Page estimate based on proprietary metrics.

EXT The file extension or file type.

FAMILY
The family ID number. Related documents (such as an email and its
attachments) share the same family ID number.

FILETYPE The document type (File, Email, Attachment, Container, Binary)

FROM Sender of email.

ID
The unique document identifying number used for tracking. Documents that
are duplicates of each other have different IDs. (See Pith, below.) 

ISSUES The issue codes (if any) assigned to a document.

KEYWORDS The document keywords (Microsoft Office documents only)

LANG The document language (Microsoft Office documents only)

LASTMODBY The date the document was last edited (Microsoft Office documents only)

LASTPRINTED The date the document was last printed (Microsoft Office documents only)

MARK The production designation (if any) assigned to a document.

MARKED ON Date document was marked.

MD5 The document's MD5 hash value. 

MODIFIED The date the instance of the document was last modified.

MSGID Email message identifier extracted from header.
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Column Displays….

OCR Indicates whether or not the document has associated text.

PAGES The number of pages in the document (if known).

PATH The original location (path) of a document.

PITH
Documents that are duplicates of each other share the same pith number.
(See ID, above.)

POD The protective order designation of the document

PRIV AUTHOR Saved name of document author for Privilege Log.

PRIV BASIS Saved basis for privilege designation.

PRIV CC Saved names of CC recipients for Privilege Log.

PRIV DATE Saved privilege date.

PRIV DESCR Saved description of privilege.

PRIV ENTRY Date the privilege log entry was saved to Privilege Log.

PRIV REVIEWER Username of account that saved Privilege Log entry.

PRIV SENTTO Saved names of recipients for Privilege Log.

RECEIVED The date the email was received.

REDACT STATE Redaction state of document

REVIEWER Username of account that applied current Mark or Issue Code.

REVISION The document revision number (Microsoft Office documents only)

SENT Email sent date.

SIZE Number of bytes in the native document.

THREAD GROUP ID of the containing thread.
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Column Displays….

TITLE
The document’s original file name. If the document is an email, this field
displays the email subject line.

TO Recipient of email. 

VERSION The document version number (Microsoft Office documents only)

XREF Loadfile cross-reference column used for Overlaying Metadata

Note: The File icon column always appears at the far left, regardless of the other columns are
arranged. It cannot be hidden or removed from the Document List.

These columns are specific to the Drafts and Productions views and only appear in the Document
List there: 

Column Displays….

Production State
Icon

BATES PREFIX The Bates prefix of the document

BEG BATES The numerical value of the beginning Bates number of the document

END BATES The numerical value of the end Bates number of the document

ERROR
The error description of problems encountered during the production
process

PDS The internal ID value of the production

PRODUCTION The name of the production containing the document
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SEQ The sequence number of the document within the production

STATE
The production state of the document (Draft, Converted, Endorsed,
Produced, Error)

TYPE The production type of the document (Image, Native, Withheld)

Duplicating Columns for Editing

Duplicating any column as a "Custom Column" allows the editing of the values in that column. 

As example, to alter the dates for a set of documents right-click on the DATE column header and
select Duplicate as Custom Column. This will create a new column called DATE_CUSTOM.

The values in the DATE_CUSTOM column can be changed by double clicking a specific cell. This
double click action will make the cell editable AND bring up the document browser. Click on the
drop down arrow to bring up a calendar to use to choose a date.

To change the name of Custom Columns under Settings-Edit Columns .48
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Note: Duplicating a column as a Custom Column duplicates ALL of the values in the source column
for the entire database, not just for the records currently in your filtered result set. 

Updating Custom Columns With Values From Another Column

To populate Custom Columns with values from another column of the same data type (text,
number, date):

1. Right-click on the column header of the custom column to be updated (the destination
column).

2. Select the Update from... option

3. Choose a column from the fly-out menu (the source column).

4. All empty cells in the destination column will be updated with the values from the
selected source column. Any values already existing in the destination column will not be
overwritten.

Editing Data in Custom Columns

To edit the contents of a single Custom Column cell, simply double-click the cell and it will allow for
the edit of the value.

To clear the contents of a Custom Column select one or more cells and hit the Delete key on the
keyboard.

Data can be pasted from Excel and other sources into Custom Columns as long as:

1. The data being pasted is a single column

2. The selected cells to be pasted into are all in a single column (multi-column selection will
not allow paste)

3. The data type (text, number, date) matches the data type in the destination column
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4. The Custom Column is not locked for editing (See Custom Columns  ) for information
about locking/unlocking custom fields.)

Note: An error will display if the data being pasted does not match these criteria.

If a single cell is copied, paste that into more than one cell by shift-selecting cells in a column and
then pasting. The copied data will be replicated to all cells. This behavior mimics the copy/paste
behavior in Excel.

Assignments

To create Assignments select that option on the Search button drop down. The documents which hit
on the current filter selection will be added to individual assignments based on the selected size.

Note: A document can be in only one Assignment. 

The Create Assignment dialog box will appear:

49
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The assignment size will vary as the documents are first segregated for the assignment and then the
family members are added to the assignment. 

NOTE: To include full families in Assignments, run your search using Search with families, save the
results to a Binder, place a check mark next to the newly created Binder, click on the drop down in
the search button and choose Create Assignments.

Applying Marks, Issue Codes, Comments

As documents are reviewed, work product is applied using Marks and Issue Codes that are specific
to the matter. Comments are also available to be applied to particular documents or groups of
documents.

To assign a Marks, Issue Codes, or Comments on one or more documents using the right-click menu
in the Current Docs grid screen.

To assign Marks, Issue Codes or Comments in bulk using the Work Product Palette  from the Tools
menu. 

To assign Marks, Issue Codes, Comments, or add Privilege Log information use the Work
Inspector  from the Tools menu.

126
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Current Docs Grid Screen

To add work product using the Current Docs grid screen, select the document or group of
documents from the Current Docs grid screen and right-click to open the menu:

Select the desired Mark or issue code.

To bulk code documents from the Current Docs Grid Screen press CTRL+A or use the Select All
button under Tools to select all of the documents in the Current Docs grid screen.

To select contiguous documents by clicking on the first document, then hold down the Shift key on
the keyboard, and click the last document. All rows including the first and last are selected.

To select non-contiguous documents click on the first document, then hold down the CTRL key on
the keyboard, and click on the other documents one at a time.

While the documents chosen are still highlighted, right-click and choose the appropriate Mark,
Issue Code or Comments from the menu.
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Note: Documents can have only one Mark but may have multiple Issue Codes. Comments are
automatically saved.

Work Product Inspector

To assign a Mark, Issue Code, or Comment to a single document at a time using the Work Product
Inspector under Tools:

Click on a document in the Current Docs grid screen, then click on the Work Inspector button to
open the Work Inspector dialog box where to check/uncheck the appropriate Mark, Issue Code(s),
or add a Comment.
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The Propagate comment to duplicates (will overwrite) check box at the bottom of the Work Product
Inspector (see above) refers to the information added in the "Add comment here" box only and
does not impact the Mark or Issue Code(s) applied. 

Note: Documents can have only one Mark but may have multiple Issue Codes. Comments are
automatically saved.

Work Product Palette

To assign a Mark, Issue Code, or Comment to a group of documents using the Work Product Palette
under Tools:

Click on a group of documents in the Current Docs grid screen, then click on the Work Palette button
to open the Work Product Palette dialog box:
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Check the box for the appropriate Mark and Issue Codes or add a Comment and click Apply. 

To remove Marks from all selected documents by selecting the Unmark check box.

To delete certain Issues Codes from all selected documents, select the Delete radio button, then
check the Issue Codes that you want to remove.

Binders

Binders are a useful way to organize the Review process by group documents into different Binders
and Sub-binders.

Note: Putting documents in a Binder does not copy them or move them in any way; it just helps to
organize them.

Best Practice: A good use for Binders is to group of documents in a Binder which were located
through a complex search to avoid having to perform the same search multiple times.

To create a Binder:

At the filter tree, right-click on Binders and select New Binder:
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Type a name for the Binder and click Create Binder:

The new Binder will now appear in the filter tree:

To create a Sub-binder:
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Create a new Binder according to the procedure above.
Right-click the parent Binder and, clicking New Binder from the menu that appears, type the name
and click Create Binder.
The Sub-binder now appears beneath that Binder name.

To add documents to a Binder or Sub-binder, use one of the following methods:

In the Current Docs grid screen, right-click, and select Add to Binder. When prompted, click the
name of the appropriate Binder or Sub-binder:

To Remove documents from a Binder or Sub-binder:

Select the binder or Sub-binder and run a search for the results to populate in the Current Docs Grid
Screen.
Select the document row(s) you want to remove from the Binder or Sub-binder
Right-click on the selected row(s) and select remove from Binder.
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To remove a Binder or Sub-Binder:

Right-click the Binder name and click Remove Binder from the menu that appears.

Note: A Binder cannot be removed unless its Sub-binder(s) are already removed.
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Click Yes.

The Binder name disappears but the document(s) from the Binder remain in the Matter.

To add comments and/or prevent changes to a Binder or Sub-binder:

Right-click the Binder name and click Binder Properties…
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The Binder Properties window contains a free-text field (Notes/Comments) where notes and
comments can be recorded about the binder. If the binder contains the results of a keyword search,
the field could be used to list the keywords, or a description of the process that led to the results. 

Check the Read Only check box and close the dialog box. The icon next to the Binder now has a lock
icon added to it. Uncheck the Read Only box at any point to undo the action.

To dedupe a Binder or Sub-binder:

Right-click the Binder and click Binder Properties.

Click the Dedupe button. If any documents in the Binder share the same pith number (i.e. duplicate
content), all copies but one are removed from the Binder. 

Note: "Deduping" a Binder or Sub-binder is a way of removing duplicate copies of documents for the
convenience of reviewers. Review automatically propagates document decisions (Marks, Issue
Codes, or Comments) to any other duplicate documents in the database (except as noted above), so
no information is lost when dedupe is applied.

Overlaying Metadata

To overlay metadata onto a set of documents:

1. Right-click on the filter tree and select Overlay Metadata from the menu that appears. 

2. Using the Browse button, navigate to the location of the load file (either .dat or .csv).
Once the load file has been specified, the fields are auto-populated in the Overlay
Metadata dialog. 
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3. From the Load File Key Column drop down, select the field of the load file that contains
the unique record identifier in order to map to the records in the database; typically this
is the document’s starting Bates number. The Load File Key Column must contain values
unique to each file in the collection. 

4. The "Use alternate culture for load file" check box allows for the selection from a drop
down of different cultures that reflect different naming conventions for fields such as
dates. For example, the date January 1st, 2018 would appear in English (United States) as
1/31/2018 whereas the date in French would appear as 31/1/2018.

5. Create the mappings between fields in the load file and data column by dragging the load
file’s Source field names to the right-hand side and dropping them in the First or Second
columns. This is aided by having some familiarity with the load file’s contents. For
example, knowing that document file extensions were included in a load file field called
EXT, one would pair EXT with the "Extension" DWR column. 

When providing a mapping in both the First and Second columns of any given row, the
specified source fields will be concatenated together into the single DWR column.
This action is most commonly used for load files providing Date and Time in two
separate fields where it is displayed in DWR in a single field.
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6. When done identifying mappings, click Apply to update the database. The dialog’s
progress bar will show that the process is complete. 

Redaction

Important: Before redacting the document must be imaged.

If the document has been imaged, the Image tab will be in the Document Browser:

If the document has not yet been imaged, right-click on the document in Current Docs grid
screen and select Image document for redaction.

Redaction is a three step process, Flag for Redaction, Redact, Approve. These processes
are explained in detail in the next several sections of the User Guide.
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Performing Redactions

To redact text from documents, right click on the document in the Current Docs grid screen
and select Flag for redaction:

The Redact State column in the Current Docs grid screen will now be set to Flagged:

By clicking on Flag for redaction the Redaction tool button is activated:
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To apply the redaction click on the Redactions tool button ( ) and use the mouse to outline
the section(s) of the document to be redacted. A transparent box is created shaded box over
the selected section(s) of the document:

The Redact State column in the Current Docs grid screen will now be set to Pending:
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Editing or Removing Redactions

To remove one redaction: Right click on the redacted text and choose Delete. This will remove the
shadow Redaction box from that section of the document:

To remove all redactions in the document click on the click the Clear All Redactions ( ) button
highlighted below:
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To avoid inadvertent removal of redactions you will see the following Warning pop-up box. You

must type the word YES (in all caps) and click the OK button to continue to clear all redactions:

NOTE: In order to un-flag a document containing existing redactions, remove the redactions from
the image.

Approving Redactions

Redactions will remain with a shaded box and the word "Redacted" until
approved:
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To approve a document with a Pending redaction state, select the
document in the Current Docs grid screen, right-click, then select Approve
redaction:
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Now in the Redact State column of the Current Docs grid screen you will
see Approved:

Once Approved the document will reflect the selected text as a Redaction and will
be blacked out:
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Unapproving Redactions

To un-approve redactions, right click on the document in the Current Docs grid screen and choose
Un-approve redaction:

Redaction Log

A Redaction Log Comment box is at the bottom of the redaction screen:

Comments are entered in the Redaction Log Comment box will be added
to the Redaction Log which can be found in the Reports under the Analysis

tab:
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Customizing Redaction Settings

 To customize the appearance of the redaction box, click the Redaction Settings button ( ) to
open a window allowing these settings to be configured. A change in settings does not modify
existing redactions but will be applied to all future redactions.

The Redaction Settings pop-up box will appear:
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Use the Reset button to return to the default values. 

Note: In order for the Redaction Text appear in color the underlying image much be in color. Before
redacting the document it must be imaged in color.

By right clicking on a redaction settings are available for each redaction. Text Properties modifies the
text that appears on an individual redaction.
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Notes

 To add Notes to documents, click on the Note button located at the upper right side of the
Document Browser:

Place one or more Notes anywhere in the document using the mouse:
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To place text in the Note, double click on the Note and type in your comments.

To delete a Note, right click inside the Note and choose Delete.

The Note will only appear in the document under the Image tab and not under the Native tab.

Notes do NOT appear on exported documents and cannot be burned into images.

Privilege Log

When documents are tagged with a Privilege-type Mark, the Privilege Metadata option in the Work
Inspector becomes available. Use this to log information that will be included in a Privilege Log
Report.

To add information for the Privilege Log Report click on the Work Inspector under the Tools menu
and select the Privileged Metadata tab.

The Author/To/CC/Date fields are populated only if the corresponding metadata was extracted
from the document. The populated values can still be edited as needed.

The TO and CC fields are note fields and available to type a unique entry or select from the drop
down menus.

In the Basis field, enter the type of privilege to be asserted. Select a pre-defined privilege basis by
clicking the drop-down at the right. See Privilege Reasons  for for more information on pre-
defining privilege basis.
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In the Reason for Privilege field click the arrow at the right and select a reason from the drop-down
list that appears. These fields are also note field in which other information can be typed.

When finished, click the Save button at the bottom right of the Privileged Metadata dialogue box.

To view the Privilege Log, click on the Analysis - Reports :

For more information on the various Reports available go to Reports .

Removing or Modifying Data

Options are available to modify documents with the right click - Document Tools menu
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Changing the file extension renames the underlying file to the typed extension.

Remove from Review.....places the document outside of review but makes them available to be
placed back via the Review Policy.
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Delete from Matter permanently deletes the file from the sever. To add the document back would
require it be re-processed.

CTRL+Right Click on a Binder to activate the option to remove binder contents from Review or
Delete contents from Matter.
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Clawing Back Produced Documents

Once a document has been clawed back it cannot be returned without re-processing the document!

In the Document List, right-click a document selecting Document Tools - Clawback....
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Select the required option for the clawback action.

 "Sequester" an entry is added to the Clawback Log and the gray flag appears in the Grid
Screen for the document. No files are removed or replaced with placeholders.

"Delete" a document,

a. From Review:

i. Adds an entry to the Clawback Log for all MD5 duplicates of the selected file.
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ii. Deletes the Native file from the repository and replaces it with a placeholder
image indicating the document has been clawed back. This affects all MD5
duplicates of the file! 

b. From Produced:

i. Adds an entry to the Clawback Log for all produced instances of the selected file id.

ii. Deletes the Endorsed images for all produced instances of the selected ids from
their respective productions and replaces them with placeholder images indicating
the documents have been clawed back. The native files are left intact and are not
affected. (See Placeholder Images  for information about the clawback
placeholder image.)

Create Production

To create a Draft production, right-click a document or a group of documents and selecting Add to
production… -> New production… To add a document or group of documents to an existing Draft
production by right-clicking and selecting Add to production... and choose one of the existing
productions shown. 

When a large set of filtered results need to be added to production hold down the CTRL key while
clicking on the Search button:
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Right click on Draft Productions to add to a new production:

After creating the new production it must be selected for the filter results to be added:
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In Drafts work is done to collect, manage, and produce a set of reviewed documents for delivery to
the requesting party. 

There are four steps in the Drafts to move through a production and these steps remain the same
whether working with 10 documents or 10,000 documents:

Create, Prepare, Endorse, and Finalize

Prepare Production : Documents being produced in an image format are converted to TIFF and
documents produced as natives are indicated in the production set 

Endorse : Slip sheets created for documents being produced as native or withheld as well as
Bates numbers, PODs, and redactions are burned onto the images

Finalize : Checks are completed for any errors and the production set is sealed

Abandon : Remove the production set and reset any bates numbers applied

Production Settings : Select the settings for the production set
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Processing a Draft Production

Converting documents to images is an iterative process. The system processes documents in
productions in 4 distinct "phases":

Phase What the software is doing When this phase executes

Sequenc
ing

Checks to see that all documents have
been assigned a sequence number. The
sequence number determines the order
in which documents will be processed
and assigned Bates numbers. If new
documents have been added to the
production DWR will offer to either re-
sequence the production so that the new
documents are sequenced properly or
add them on to the end of the
production.

After configuring the settings for your
production. See Production Settings .

Conversi
on

For documents being produced as
natives, this phase is very fast as there is
nothing to "print". During this phase, the
production is examined for documents
that have not yet been converted to
images. 

After right-clicking your production and
selecting "Prepare Production..."

Bates
Assignm
ent

The production is examined to make sure
all documents have a Bates number. If
errors occur during conversion,
documents will have a page count of 0. In
these cases, DWR is unable to assign a
Bates range. Resolve the errors or remove
the problem documents from the
production so that Bates numbers can be
assigned.

After right-clicking your production and
selecting "Endorse production..."

Endorse
ment

The production is examined to make sure
all documents that have been assigned
Bates numbers have been endorsed. For
documents being produced as natives,
this phase involves copying the native
document into DWR's internal production
location and generating the slip sheet.

After Bates numbers have been assigned.

If a document encounters an error at any phase, you will need to resolve the error and restart the
appropriate production phase to continue. See Triaging Production Problems  for more details on
resolving problems. 
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Prepare Production

Prepare Production step examines the production for documents that have not yet been converted

to images and notes which documents are being produced as natives.

To run the Prepare Production step from the Drafts menu click Prepare or right-click the production
and selecting Prepare production

The first time Prepare production is applied to a production the tool will proceed through the

Production Settings . With those setting selections made, the conversion process will begin.

To monitor the progress of the conversion select the "View Jobs" button under the Process menu. 

An indicator appears on the Process tab to report a process is running:
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Production State filter options update the grid screen to only the documents remaining to be
converted or which have an error.

Once the conversion process is completed, sort the production by the PAGES field and confirm each

document has a page count greater than 0. Any blank or zero page counts will need to be flagged for

reconversion and the Prepare Production process run again. Also check the Error column. For

documents with an error see Triaging Production Problems .

Only after all documents are converted and have a page count greater than one can the

Endorsement begin. During this phase, the numbering, confidential designations and redactions are

burned onto the images. For documents being produced as natives this phase involves copying the

native document into the internal production location and creating the slip sheet.

Once the endorsements are complete, the production can be finalized and moved to the Produced

side of the tool where it can be exported. (Finalizing a Production , Exporting a Production )

Endorse

During endorsement the production is analyzed to confirm all documents have an assigned Bates
number. If errors occur during conversion, page counts will remain blank or at zero and the error
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column may be populated. Errors will need to be resolved or the documents removed from the
production to continue.

To Endorse a draft production from the Drafts menu click Endorse or right-click the Production and
select Endorse production.

The numbering, confidential designations (PODs) and redactions are burned onto the images. For
documents being produced as natives this phase involves copying the native into DWR's internal
production location and creating the slip sheet.

Once the endorsements are complete, the production can be finalized and moved to the Produced

side of the tool where it can be exported. (Finalizing a Production , Exporting a Production )

Finalize

The last step in creating a production is Finalizing. This step checks for several kinds of errors, which
can be repaired or (in some cases) ignored before proceeding.

To Finalize a production Right-click the Draft production and select Finalize production or select from
the menu. 
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An analysis of the production is completed looking for certain error conditions. Messages will appear
with information about the production, such as the following:

If the production contains redacted documents, the following dialog reminds to re-OCR the redacted
files. (See Generating OCR/Searchable Text  for more information.)84
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If there are errors, a screen like the following will appear showing more information:
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Repair any errors and start the Finalize production again. When all errors are fixed, the following
confirmation is displayed:
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Click Finalize.

Once Finalized, the production becomes available in the PRODUCED view and can be exported with
load files. See Exporting a Production  for details.

Note: Once a production is Finalized those documents are "locked" so there will always be a copy of
what was produced. 

Abandon

Important: Abandoning a Production results in permanent loss of the production. This process
cannot be undone. Any images that were created during conversion will be retained and can be used
in future productions. Any numbering assigned to the documents will be reset.
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In the Drafts or Productions views, right-click a production and click Abandon Production… or select
from the menu:

The Abandon Production dialog box will appear:

Type YES to proceed and then click OK.

Production Settings

To access the production settings right-click a production draft and click Production Settings … or
select from the menu:
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In the Bates Prefix field, type the prefix to appear before the Bates number. The system sets
CONTROL- as the prefix by default.  If the matter has multiple bates prefixes in use all prefixes
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previously used will appear on the drop down.  The Starting Bates will be calculated from the last
finalized production with that prefix.

In the Starting Bates field, type the Bates number at which this production will start. The default
setting is 1 or EndBates+1 of the last finalized production with that prefix.

In the Bates Pad box, type the number of the Bates pad. This is a number of digits in the Bates
number; for example, if you type 4, the first Bates number will be 0001. The default setting is 8.

In the Production Sequence section, chose how you want the Production to be sequenced.

Note: Attachments always immediately follow their containing email, unless the third option,
"Order by column," is selected. If "Order by column" is selected, the Production will be sequenced
based on the column selected in the drop-down box.
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Select the options for Image Type, Resolution, Paper Size, and Orientation from the drop-down
menus. When the Paper Size and Orientation options is "Default", DWR will rely on the native
printing application’s settings for determining paper size and orientation.

When all documents in the Production are set to produce as Native, the Image Conversion Settings
dialog displays a check box option generating placeholders for the documents in the production.

For Productions containing a mix of production types (Image, Native, Withheld) any document set to
type Native will automatically be produced with a placeholder image.

The placeholder images can be customized by clicking the Customize Placeholder Images (this
production only) button. See Managing Placeholder Images  for more information.176
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Configure the print settings for Microsoft Office documents.

Important: When imaging a document that contains user-set print areas, those print areas are over-
ridden and all printable space is imaged. When imaging a document that contains tracked changes,
DWR prints the most current version of the document regardless of the approval state.
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Use the drop-down lists to specify which fields are endorsed in which location on the produced
images. The fields available for endorsement are limited to the columns turned on in the
Productions view. (See Edit Columns  for more details.)

Important: Changes to Production settings only affect the current Draft Production and do not affect
any other Draft Productions.

Triaging Production Problems

When the Production process encounters a file that causes issues during image conversion,
endorsement, or OCR, resolve the Problem and then start the Production processing again. 

Triage Steps:

1. Use the Production state filter in Drafts to return just the documents in your production
that are in an error state.
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2. Use the ERROR column in the Current Docs grid screen to determine the nature of the
error. Common errors include:

a. No application associated with extension "xxx" – This indicates that you do not have
an application on your system configured as the print handler for the specified file
extension. Either install an application that knows how to print the specified
extension or configure a custom print application to handle that extension. (See
Custom Print Settings  for more details.)

b. Document conversion timed out – The document took too long to convert to image.
You will need to adjust the timeout settings for the document’s file extension in the
Custom Print Settings interface, flag the document for re-conversion, and start the
Production again. (See Custom Print Settings )

c. 0 page count – This indicates that for some reason, the document was not converted
or endorsed correctly which resulted in an error. Try flagging the 0 page count files for
re-conversion and then start the Production again.

d. Endorsement Canceled – This indicates that the document was in the middle of being
endorsed when the Production was stopped/canceled. You will need to flag this
document for re-endorsement and start the Production again.

e. Conversion Error: Page count not set. Try flagging for re-conversion - This usually
indicates that conversion was canceled while documents were in process of printing.
Flagging for re-conversion and restarting the production usually fixes the problem.

3. If you are unable to resolve a particular error there are two options:

a. Manually print the document to an image file outside of the DWR system. 

i. Export the file out of DWR.

ii. Open the file in an application that knows how to print it.

iii. Print to the "Digital WarRoom Printer" which will save the "printed" document as a
TIF image.

iv. Then use the Replace document feature to replace the pre-production image in
the Draft production. 

b. Remove the file from the Production. Be aware that this may create Bates gaps which
can be resolved by re-sequencing the Production after removing files.
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 Clear the errors on individual documents by right-clicking the document in the Current Docs grid
screen and selecting Clear errors. 

 This will reset the error-state documents to the last successful phase and continue from there. For
example, if a document encountered an error during the Endorsement phase, it will be reset to the
Converted state so that endorsement can be re-attempted. 

Production States

DWR displays information about the status of each document in a Production. 

The Production State column will display one of these icons:
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State Meaning

Unconverted 
This document has been added to a production and has not
yet been processed, or this document was flagged for re-
conversion. 

Converted
This is a document that has been imaged/converted. This is
also the state that a document goes back to when it is flagged
for re-endorsement. 

Error
An error occurred when trying to either convert, endorse, or
OCR the document

Endorsed This is a document that has been successfully endorsed.

The ERROR column displays messages passed from the operating system about errors encountered
during the production processing phase: 

Together with other relevant information such as document types, installed applications, and
production state data, the messages in the ERROR column may help diagnose and resolve issues
related to imaging documents.

Setting Production Properties

Right click on the production draft to change the title of a Production and/or provide a detailed
description of the contents of the production.

The title can also be modified by double clicking the title in the filter tree.

In the Drafts or Produced views, right-click a Production and select Properties... from the menu that
appears.
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Supply the appropriate information and click Apply. If the properties are not modified, upon
finalization the Production Title will be updated to be the Bates Range of the finalized production.



172 Chapter 10 Drafts

10Drafts



173Chapter 10 Drafts

10Drafts

Canceling Conversion or Endorsement

To cancel any production step go to Process - View Jobs and right click - cancel Job:
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Production Placeholder Images - Native

For an all native production, right click and choose Produce as... -> Native for the entire production:

Next, right-click on the Production and click on Production Settings:
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The Production Settings dialog box will appear. Click on the Image Settings tab to Generate
placeholder images for this all-native production:



176 Chapter 10 Drafts

10Drafts

Production Placeholder Images - Customize

Placeholder Images for a specific Production can be modified. Only the specified Production will
use the custom Placeholder Images.

Right-click on the specific Production and select Production settings...
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Go to the Image Settings tab where the Placeholder Images can be customize for this Production
only:
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Click Customize Placeholder Images (this production only). The Production Placeholders dialog box
will appear;
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Choose the type of placeholder to be replace (Native, Withheld, or Clawback)

Click Replace and browse to the replacement image. 

Click Open. The image will update to the replacement image. 

Clicking Restore Default for any of the placeholder images will restore that image back to the
corresponding image above.
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Returning a Production to Drafts

Once a Production is Finalized, certain operations are not possible:

· Re-endorse

· Re-convert

· Withhold documents 

· Change and edit redactions

To make changes to a Finalized Production, return it to Drafts by right clicking the Production and
selecting Return production to Drafts...:

The Revert production to Drafts? dialog box will appear:
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Type YES to accept these warnings before the Production will be returned to Drafts for editing.

Filtering Draft Productions

In the Drafts view the filter tree on the left side of the screen to is available to filter and search for
documents:
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The Production State filter is only available in the Drafts view:
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Synchronizing Production Types and PODs

When changes are made to either the POD/Mark associations or to the Custom Print Setting after
documents are already in a Draft Production, to apply those changes to the Draft Production, right-
click the Draft production, select tools, and select either Synchronize PODs or Synchronize
production types.

Important: Synchronizing PODs and/or production types may require that some documents in the
Draft Production be re-converted or re-endorsed. Make sure to right-click and select Prepare
production… after using these synchronization options.

Production Settings for Individual Documents

In a Draft Production, the right-click menu is available to change specifications for the selected
document(s).
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Flag for Re-conversion to remove the existing images and re-convert or send a document back
through the conversion settings to address zero page counts or errors.

Flag for Re-endorsement to remove the current endorsements

Clear errors to set a document back to the last successful production state (i.e. Draft, Converted,
Endorsed).

Produce As to change production type, click this and select an option from the list that appears:
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· Native: to produced a file in the native format (recommended extensions include
.MPEG, MP3, large .TXT or .LOG files, .XLS and .XLSX files, and binary or system files).
Native files are always produced along with a placeholder image indicating that the
document was produced as a native. The placeholder image will contain the
endorsement (Bates and POD).

· Image: This file is to be produced as an image.

· Withheld: to produced a placeholder image informing the recipient that the document
was intentionally withheld.

· Image Color: to change the color settings, click this and select an option from the list that
appears.
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POD (Protective Order Designation): Click POD and select the appropriate POD from the menu
that appears for documents not assigned POD based on Mark or modify the assigned POD:

Remove from Production to remove this document from the production.
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Add to Production to add documents to another production, click Add to production and click the
appropriate draft Production from the menu that appears. A document can be in any number of
Productions at the same time.

Clear Bates numbers from here down: This option will remove all bates information from the
selected SEQ to the end of the Production. The Bates information will be regenerated the next
time prepare production is ran. This option can save you from having to re-endorse an entire
Production if you have to remove or change a document near the end.

Removing Documents from a Production

Select the document(s) to be removed.

Right-click the document(s) and select Remove from production:

Important: It is possible that removing a document from a production can cause the production to
have a Bates gap. To ensure that the production does not contain any gaps in the Bates range, re-
sequence and re-endorse the production. Re-sequence by right-clicking on the draft production and
selecting Re-sequence Production…. No other changes need to be made. 
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To replace a pre-production (un-endorsed) image in a Draft production:

The steps for replacing a document are covered in Replacing Documents in Review . The same
steps apply in Drafts. 

This section of the tool is used to review the specific instances of produced documents on behalf of
the client and the exporting of productions for delivery to the requesting party.

Produced images appear in the Images tab in Review, however, when documents have been
produced multiple times the Produced view is necessary to locate a specific instance of that
document.
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Exporting a Production

Right-click the Production name and select Export production:

Make the selections required for the production export.

 

In Loadfile Columns, select the columns of metadata that will be included in the load file.
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Important: Only those columns added to the Productions view will be available to add to load
files. See Edit Columns

Important: Ensure that the load file contains only the fields to be produced to the recipient.

Important: The column selections will persist for each subsequent production.

To change the default location of the Destination Directory, use the Browse button next to the
Location field to find a directory, select it and click OK so the new directory appears in the Location
field.

In the Volume field, label this production with a volume number, type the name of the production
volume – alphanumeric characters.

To cancel Production export:

To cancel the production export click the Cancel button while it is running. When the production
export is canceled in the middle of exporting, restarting it later by clicking Export Production again
will cause an alert:

By continuing the documents already exported to the destination folder will be skipped and the
export will pick up where it left off. Any load files in the partial export will be overwritten.

From the Matter menu access the User Guide, End User License Agreement(EULA), and register the
PRO software by clicking on Help:
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User Guide

Access the User Guide by clicking on the User Guide button or link to our User Guide (Hotkey: F1)

About DWR

From the Help menu by clicking on About DWR the welcome screen displays the version, expiration
date, etc. for Digital WarRoom

Register

To register Digital WarRoom PRO click on on the Register icon and request a license via email or
copy/paste the Request Code to support@digitalwarroom.com 

mailto:support@digitalwarroom.com
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EULA

To review the Digital WarRoom End User License Agreement click on EULA:

It is often very useful to run DWR in Console Mode with logging to capture additional information
when trying to troubleshoot an issue. 

To do this, launch the tool from the command line using the /c and /log:<path> arguments. (<path>
is the destination where you wish to place the console log.)
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A Boolean search request consists of a group of words or phrases linked by connectors (such as AND
or OR) that indicate the relationship between them. The following table includes examples of
Boolean search requests.

Search request Meaning

apple AND pear Both words must be present.

apple OR pear Either word can be present.

apple w/5 pear "Apple" must occur within five words of "pear."

apple AND NOT pear The word"apple" must be present and the word
"pear" must not appear.

sender contains smith The sender field must contain the word "smith."

mail(sales@onecorp.com) Email must include the address
"sales@onecorp.com."

mail(t*@onecorp.com) Email must include any email account beginning
with "t" at onecorp.com.

apple w/5 xfirstword "Apple" must occur in the first five words.

apple w/5 xlastword "Apple" must occur in the last five words.

creditcard(1234 5678 1234 5678) The specified credit-card number must occur. 

AND and OR connectors

The AND and OR connectors connect two terms. 

· When the AND connector is used, both terms (before and after the AND) must be found in
a document.

· When the OR connector is used, either of the term (before and after the OR) must be
found in a document.

For example: 

mailto:t*@onecorp.com
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· When "apple pie" AND "poached pear" are the terms, the search returns any documents
that contain both phrases. 

· When "apple pie" OR "poached pear", the search returns any documents that contain
"apple pie," or "poached pear," or both.

When using more than one connector, use parentheses to indicate precisely what to search .

 For example, without parentheses the search query apple AND pear OR orange has two possible
meanings: 

1. The document must contain apple and pear (both terms) or just the term orange

(apple and pear) or orange

2. The document must contain the term apple and either the term pear or orange

Apple and (pear or orange)

The NOT connector

Use the NOT connector to exclude terms from the keyword search. For example, to find documents

that contain the word applesauce but do not contain the word pear the search would be:

applesauce and not pear

The NOT connector can be used at the start of a search request to exclude all documents that
contain particular words. For example, to exclude documents that contain the word "apple," type
NOT apple. If NOT is not the first connector in a search request, however, you must combine it with
AND or OR. For example, you may not type applesauce NOT pear; instead, type applesauce AND
NOT pear or applesauce OR NOT pear.

The W/n connector

Use the W/n connector to specify that a single word or phrase must occur within n number of words
of the other. For example, the query apple w/5 pear finds any document that contains "apple"
within five words of "pear." The following table shows examples of search requests using the W/n
connector.

Search request Meaning

(apple or pear) w/5 banana The word "apple" or the word "pear" must occur
within 5 words of the word "banana."

(apple w/5 banana) w/10 pear The word "apple" must occur within five words of
the word "banana," and this must occur within ten
words of "pear."
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(apple AND banana) w/10 pear Both words "apple" and "banana" must occur within
ten words of "pear."

A related connector is PRE/n, which specifies that the first expression must occur before the second
expression. For example, if you type (apple AND pear) pre/5 banana, the words "apple" and "pear"
must occur five words before the word "banana."

Searching for a phrase

To search for a phrase, type the phrase using quotation marks around it. 

For example, use quotations marks to search for files that contain the phrase: "res ipsa loquitur" or
"employee at will"

Searching for email addresses

To search for text that follows the syntax for a valid email addresses using the mail(…)operator:

Search request Meaning

mail(sales@onecorp.com) Email must include the address
"sales@onecorp.com."

mail(t*@onecorp.com) Email must include any email account beginning
with "t" at onecorp.com.

mail(*@onecorp.com) Any email account at onecorp.com.

There are certain fields like "sender" and "recipient" and "CC" that can be searched using keywords.
This search finds all emails to or from "onecorp.com" email addresses:

(sender contains (mail(*@onecorp.com))) OR (recipient contains (mail(*@onecorp.com))) OR (CC
contains (mail(*@onecorp.com)))

Searching for credit card numbers

To search for credit card numbers using the creditcard operator, and any numerical sequence that
credit-card issuers use to determine card validity, regardless of spacing and punctuation, is
recognized. For example, the following sequences will all return text following the number
specified:

creditcard(1234 5678 1234 5678)

creditcard(1234-5678-1234-5678)

mailto:t*@onecorp.com
mailto:*@onecorp.com
http://wellsfargo.com/
http://wellsfargo.com/
http://wellsfargo.com/
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Occasionally, other numbers may also be returned by this operator.

Searching for Social Security Numbers

Use the regular expression keyword search below (include the quotes) to find documents containing

social security numbers. Unfortunately, it will also return some international phone numbers since their

formats look similar to SSNs. We recommend you search for "SSN" and the string "Social security

number" as well. If you have images of form data that has been OCRed, the search for "SSN" may be

more reliable since the numbers in the OCR may not quite match the pattern due to OCR errors.

"##(\d{3}[\.\-])(\d{2}[\.\-])(\d{4})"

Will find things like:

123-45-6789

123.45.6789

Will not find things like:

123 45 6789

This search string will get all documents that contain SSN or Social within ten words of a social security

number:

(ssn or social) w/10 ("##(\d{3}[\.\-])(\d{2}[\.\-])(\d{4})")

Wildcard and special characters

Special characters are symbols that can represent a range of possible results. The following table
shows a list of these and their meanings.

Special character Meaning

? Matches any single character

= Matches any single digit

* Matches any number of characters

% Adds fuzziness to the search (see Fuzzy search requests) 

# Applies phonetic searching to particular words (see Phonetic searches)

~ Applies stemming rules to particular words (see Stemming rules)

Note: Using special characters may increase the time required for search results to display. 
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The following table shows three examples of how to use special characters.

To find all documents containing… Type this:

The words "apple" and "application" appl*

The words "apple" or "apply" appl?

Either 92.168.10.85 or 192.168.10.25 192.168.10.=5

Fuzzy search requests

Use fuzzy searching to help find a word, even if it is misspelled. For example, a fuzzy search for the
word "apple" could find "appple" or "aple." Fuzzy searching can be useful when you search text that
contains typographical errors—for example, informal emails, or text that has been scanned using
optical character recognition (OCR).

The % character adds fuzziness to the search string, and the number of % characters specifies the
number of differences the search engine ignores when it searches for a word. The position of the %
character(s) specifies how many letters at the start of a word must match exactly.

For example, if you type ba%nana, the search returns any word that begins with "ba" and has no
more than one difference between it and the word "banana." If you type b%%anana, the search
returns any word that begins with "b" and has no more than two differences between it and the
word "banana."

Phonetic searches

Use phonetic searches to find words that begin with the same letter as a particular word and have
the same approximate phonetic sound. For example, a phonetic search for the word "Smith" also
returns the words "Smithe" and "Smythe." To search for a word phonetically, type the # symbol in
front of that word. For example, to search for phonetic matches to the word "Smith," type #Smith.

Stemming rules

Stemming rules expand your search to include grammatical variations of keywords in the results.
For example, such a search for the word "apply" would also return "applies," "applying," and
"applied." 

To apply stemming rules to a particular word in the keyword search, add the ~ symbol to the end of
the word you want "stemmed"—for example, appl~.

“Noise” or “stop” words

To create efficient searches, the tool ignores commonly used words such as "if" or "the." The list of
default noise words appears below. An administrator can change these if necessary.
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a did into out thus

about do is over to

after each it said too

all even its same under

also for just see up

an from like she very

and further made should was

another furthermore many since way

any get me some we

are got might still well

as had more such were

at has moreover take what

be have most than when

because he much that where

been her must the which

before here my their while

being hi never them who

between him not then will

both himself now there with

but how of therefore would

by however on these you
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came I only they your

can if or this

come in other those

could indeed our through

The following table includes terms used throughout Review. 

Term Definition

Collectio
n

A distinct set of documents that were processed together and associated with one or
more custodians.

Custodia
n

Name indicating the source of the documents, such as the hard drive, network share, or
media. This is not necessarily the author of the document, as the document could be
stored on, and collected from, someone else’s hard drive. 

Documen
t

Electronic file or email message.

Duplicate
documen
ts

Documents that have the same pith value.

Family
Collection of related documents such as an email and its attachments or files with
embedded content (PowerPoint with embedded Excel chart).

ID Unique number assigned to every single document in the database. 

Issue
Codes

"Tags" used to denote one or more factual issues related to a document. Documents can
have an unlimited number of Issue Codes. Examples of common Issue Codes are "Hot",
"Strategic", and "Financial Plan".

Marks 
Designations that describe the disposition of a document. Examples of common Marks
include Privileged, Non-responsive, and Produce. Marks are mutually exclusive; a
document can have only one mark.

Matter
The name assigned to the repository of documents being reviewed; documents
affiliated with a specific client’s investigation or legal proceeding. The words "Matter"
and "Database" are interchangeable.

MD5 /
Forensic

Identifies exact duplicates. If the difference between the sent and received copies of
the same email may be critical enough that they need to be reviewed separately, for
example, use this method for deduping instead of Pith.
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Fingerpri
nt

Pith
Identifies duplicates of emails, such as the copies that were sent and received in
different time zones. The reviewable content for both will be identical (while differing
in aspects such as header and formatting), so deduping by pith will save you time.

Propagati
on

When attorney work product (marks, issue codes, PODS) automatically copies to all Pith
duplicates.

Scope The Binders, Collections and/or Custodians included in the review set. 

POD /
Protectiv
e Order
Designati
on

Explains the level of confidentiality of the document.

Click on the links below to go to tutorials on various functions of Digital WarRoom:

Productions Tutorial

Other training videos

The following table includes the shortcut keys available

Hot key(s) Description

Ctrl + A Selects all documents in the document list.

Ctrl + C Copies selected data to the clipboard of the local computer and
to be pasted into local applications

CTRL + K Open Keyword List Manager

https://www.youtube.com/watch?v=OqfkQXjyOOw&feature=youtu.be
https://fast.wistia.net/embed/channel/ck596fa140
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Ctrl + Shift + O Opens the Open Matter/Select a Matter dialog box.

Ctrl + Shift + T Display the Thread Visualizer window

Ctrl + Shift + H Display the Date Histogram window

Ctrl + Shift + W Display the Work Product Inspector window

Ctrl + Shift + N Opens New Matter Dialog

ATL + Enter Opens Matter Properties

Ctrl + Shift +F5 Reset Layout

Ctrl + F5 Refreshes environment settings.

Ctrl + N Opens the Manage Collections dialog box to add a new collection

Ctrl + R Opens the Review Policy dialog box

Ctrl + E Opens the Export Documents dialog box

Ctrl + W Opens the Work Product palette

ALT + Down Arrow Advance Document Bowers to Next Document

ALT + UP Arrow Advance Document Browser to Previous Document

CTRL + F Turn on Toggle Row Filters

CTRL + P Prepare Production

CTRL + SHIFT + P Endorse Production

Alt + F4 Exit DWR

CTRL + F6 Open additional browser window

F5 Refreshes the last search.

Up Arrow, Down Arrow Scrolls up or down through the document list.

CTRL + SHIFT + R Open Reports

CTRL + click column header Adds the column header to the sort order. For example, if the
Date column header is selected and the documents are sorted by
date, hold down Shift and click the EXT column header to sort the
documents first by date, and then by extension. To remove a
column from the sort order, perform a new search.
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CTRL+SHIFT F7 Run Queries window

F1 Opens User’s Guide
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